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Intended Use

A mixture of non fluorescent Silica (100nm) and fluorescent Latex (80nm) micro-spheres suspended in an aqueous

detergent soluti.on, prepared to a precise concentration, with precise light scatter and fluorescence characteristics as
required for calibration of flow cytometers. For research use only.

Approximate particle concentrations for Lot # CALO0144:

Particle Size (nm) Approximate number per microlitre
80nm 25000
100nm 50 000

Storage Conditions

The calibration beads are stable until the expiration date shown on the label when stored at room temperature.
Do not freeze. Do not expose to direct light during storage.

Instructions for Use
Please refer to the flow cytometer's Operator Manual. Use undiluted.

Warnings and Recommendations

1 Suitable for calibration of Apogee flow cytometers. Not for diagnostic use.

2 Product is stable until the expiration date shown on the label if it is properly stored. Do not use after the
expiration date shown on the label. If the product is stored in conditions different from those recommended, \4
such conditions must be validated by the user.

3 The detergent solution contains 0.1% sodium azide (CAS-Nr. 26628-22-8) as a preservative, but even so
care should be taken to avoid microbial contamination or incorrect results may occur.

4 Sodium azide (NaN3) is harmful if swallowed (R22). If swallowed seek medical advice immediately and
show the container or label (S46).

5 ltis advisable to allow the calibration beads to warm to room temperature before running on the flow
cytometer.

Explanation of Symbols

Symbol Meaning

\\y/ i Protect from light, Storage Temp Range, Consult Product
-'7|"\‘/V User Manual Before Use
" fosec

@ Harmful substance (MSDS available)
[ ]
Warranty

This product is warranted only to confirm to the quantity and contents stated on the label. There are no warranties
that extend beyond the description on the label of the product. Apogee Flow System'’s sole liability is limited to either
replacement of the product or refund of the purchase price.
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1. Apogee Flow Cytometers

v

1] Introduction

This manual covers the general operating procedures and introduces some of the instrument’s features
and unique characteristics. For help with specific applications, it is recommended to follow the reagent
manufacturer’s guidelines and one of the many books available on flow cytometry.

!
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Upon delivery/installation, you may be provided with additional operating notes and instructions for your
specific version of machine.

1.2 Intended Use

Apogee Flow Cytometers contain a sophisticated combination of optical, electronic, fluid and software
technologies. This operator manual covers the A40, A50 and A60 generations of the Micro and
Universal models. Since its incorporation, Apogee has manufactured a range of models including:

e

e Micro-PLUS model (A50 or A60 generations) for extreme small particle applications. Ideal for
extracellular vesicle research and measurement of large virus.

e Micro model (A50 or AB0 generations) offers good light scatter sensitivity for a wide range of
applications including microbiology applications.

e Universal model (A50 or AB0 generations) is ideal for conventional applications requiring up to 3
lasers, 2 light scatter and 4 fluorescence channels.

e A40-Micro model has been developed for research scientists looking for high resolution and
sensitivity from a single laser. Ideal for bacteria, archaea and other small particles

e  A40-Universal model offers up to 3 lasers, 2 LS and 4 FL, ideal for conventional mammalian, plant
or yeast cell applications.

s A20-Military model (Cat# 9018) was developed for the detection of microbial pathogens in tough
environments with minimal operator training. This self-calibrating system includes an automatic
data analysis algorithm.

e Auto40 (Cat#9900) has been developed specially for HIV immunophenotyping and offers
automated calibration and data analysis algorithms. For this model please refer to the Auto40
Operating Manual (Apogee Doc 16008, Cat#9915).

e Micro-GxP model for use in regulated environments. Refer to the operator manual dedicated to
this model: ApogeeFlow document #16057.

www.ApogeeFlow com Page 7 of 80 Doc#t 4 Rev 24
20 April 2020




THIS DOCUMENT CONTAINS CONFIDENTIAL INFORMATION
DO NOT DISTRIBUTE OR COPY WITHOUT PERMISSION

/)  APOGEE

FLOW SYSTEMS

1.3 Regulatory & Safety Information

Quality System

Apogee operates under a Quality Management System based upon BS EN ISO 13485:2003 Medical devices.
Apogee flow cytometers are for research use only unless specifically labelled as suitable for other uses.

CE Marking Policy

Unless specifically labelled for other purposes, ApogeeFlow products are CE marked for Research Use Only.

Laser Safety & Classification

Apogee flow cytometers are Class 1 laser products; there is no laser hazard. During operation the user is not exposed
to laser light. For maintenance procedures requiring removal of the covers, it is recommended to first turn all lasers off
using the check boxes on the Control Tab of Histogram Software. If the covers are removed and laser(s) are turned
on, the machine is then a Class 2M laser product; the system is safe for accidental exposure providing optical
instruments are not used to view or divert the laser light.

FCC Regulatory Information This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2)
this device must accept any interference received,
including interference that may cause undesired
operation.

Apogee flow cytometers have been tested against Code of Federal Regulations 47, Part 15, Subpart B 15.107(b) and
15.109(b).

EMC Compliance
Apogee flow cytometers have been tested and found to comply with

EN 61326-1:1997 including Amendment 1
EN 61000-3-2:2000
EN 61000-3-3:1995+ A1:2000

indicating their emissions of and immunity to electromagnetic radiation are within the limits defined by these standards

Furthermore, this device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference received
including interference that may cause undesired operation.

Any electrical device is capable of causing electromagnetic interference with other electrical devices and can
themselves be affected by other electrical equipment. Care should be taken to minimize such effects when choosing a
location for the machine
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DECLARATION OF CONFORMITY

We declare, under our sole responsibility, that the products identified in this declaration and to

which this declaration relates are CE labelled in conformity with the European Council Directives.

Machinery Directive (2006/42/EG)
Electromagnetic Compatibility Directive (EMC) (2014/30/EU)
RoHS (2011/65/EU)

Description of Equipment:
Universal Flow Cytometers

Micro Flow Cytometers
Micro-PLUS Flow Cytometers

This declaration covers the above products manufactured from 1°T January 2019

Standards applied:

IEC EN 61010-1:2010 + A1
Emissions standard: CISPR 11 / FCC Category: Class B
Immunity standard: EN 61326-1:2013 Category: Basic

The product is manufactured in the EU by:

Apogee Flow Systems Ltd.
Unit 7 Grovelands, Boundary Way
Hemel Hempstead, HP2 7TE, UK

Apogee operates under a Quality Management System based
on BS EN ISO 13485:2012 Medical Devices.

2™ January 2019 Oy
A7 S
& —_—
Date of issue 0. Kenyon
CEO
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FDA 21 CFR Part 11 Compliance

Apogee's flow cytometer user interface, the “Histogram” application, may be configured to opergte in a “GxP ‘mode
which is intended to meet the requirements of part 11 of Title 21 of the Code of Federal Regulations; Electronic g
Records; Electronic Signatures (21 CFR Part 11). The software is not certified to this standard but when configured in
“GxP” mode, the Histogram application generally meets these requirements.

This option is offered as Apogee product # 8057 and requires that the system be specially configured by an Apogee
field service engineer.

Disposal of Electronic Waste

This product contains electronic items which must be disposed of in compliance with

local regulations. Within the European Union, Apogee is pleased to arrange for the

collection, treatment, recycling and environmentally sound disposal of Waste Electrical
and Electronic Equipment (WEEE) manufactured by us.

Disposal of Waste Products

Waste fluid from the flow cytometer will contain potentially hazardous biological contaminants. Dispose of carefully and
according to local regulations.

Treat used sample tubes and pipette tips as hazardous biological waste according to local regulations.
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2. Technical Overview: Optics

i

¢ Ve

24 Flow Cell

The flow cell is at the heart of the machine and
consists of a quartz crystal through which a
flow channel allows sheath fluid, with sample
fluid & particles at its central core, to flow. The
flow cell assembly is designed for maximum
stability. If a fault or damage occurs, the
"OL&FC Assembly" (Objective Lens and Flow
Cell Assembly) can be replaced by a service
engineer. The damaged unit should be
returned to the factory for re-conditioning.

1

e
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2.2 Lasers

Apogee uses only the latest solid state laser
technology. Typical laser lifetimes exceed
10,000 operating hours. Lasers may be
mounted on the front and back of the optical
bench plate and may have some adjustment
mechanisms for service engineer use. Refer to
section 1.3 for laser product classification
information.

2.3 Optical Configuration & Fluorescence Filters

The precise optical path depends on instrument model and Software - [C\Program Fles (4867\Apogee\Protocols\Detaul |
configuration, but a schematic representation is shown here for =~ ! | s [ !
an A40 generation cytometer with 3 fluorescence detectors. . B Sowiran Fam
The photomultiplier detectors are mounted on the rear side of ‘
the optical bench (not shown).

Set Defauit Foider

|
Harsare Configuratesn: OPTICS |
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Thesholds 8 Lasers Info ‘
Contrd Service Gan PMT |
Your cytometer's particular optical configuration can be iy
displayed via the Setup menu and also by double clicking on any S o “7, an il
of the parameter names on the “Gain”, “Service” or “PMT" tabs Eni = T o ‘,
on the Control Panel of the Histogram Software. The S =1 e
configuration information is stored in the FCS file. -
AF488 00 54 000
. . W - 5 PE 75 54 0l |
This dialog can be used to enter “Short Channel Names” which o | G Rl om |
reflect the fluorophore you are measuring. pecr 56 B om
3 . % APC 00 34 000
Multiple lasers focused to the same spot (coincident lasers) i = Tl 0w
should be specified as comma separated values in the Laser 5
Wavelength control. Use numbers and commas only in this
control, no other characters. 5
|
bd W
Do not use the “/" character in any of the text because this e R Sk o Vs
character is used for formatting in the fcs standard.
| 85 Hardware Configuration: OPTICS o o X
! Channel Parameters
Short Channel Name Color  Full Channel Name Optical Fiter Name  Laser Wavelength  Laser 1 Laser 2
| ot [sas | [l [5vat Ange gt Scatter [nD1 — faes ] v No Laser -
| [AS | Bl [oroe Ange Light Scatter | [na s v No Laser 5
J - [Medum Angle Light Scatter J‘INA w‘] [435 if} Las488 ~ | No Laser
; S 27 | v, |No Laner >
J | [BP-507-583 | [«0s ) v | NoLsser >
| = [BP-680-35 | [a0s - No Laser v
~|[weza0  J[a0s | |Lasdos g K o
Ch7 [L63BRed 638 erRas
o [0 i
Cho [L488Ge v Mo Laser %
ch10[L4880g e
o 11[L488Red | v Mo Laser
Save Cancei
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2.4 Fluorescence Filter Blocks

The operator should be aware of the fluorescence filter block specifications which are written on the filter
blocks and set in the software via the ‘User Configuration’ program (shortcut on desktop). Filter blocks can
be changed by the operator using the Allen key (3mm A/F) supplied with the instrument, without the need
for realignment. The user must then remember to edit the software descriptions via the User Configuration
program.

RN EEER

i

There are two types of filter block: 'Single beam’ or 'Dual beam'. In the below picture, there are single
beam filter blocks in positions FL2, FL3, FL4 and FL8/FL9.

.

Mounting screw
(3mm A/F) for FL4
filter block

Mounting screw for
FL3 filter block

Mounting screw for
FL2 filter block

Mounting screw for
FL1 filter block

Mounting screw for
FL5 filter block

Mounting screw for
FL8/FL9 filter block
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Single beam fluorescence filter block:

Light In J

Transmitted
beam

Reflected
beam

2.5  Light Scatter Iris Field Stop Adjustment

The A50 and A60 generation optics are fitted with an iris in the light scatter path which can be adjusted by
an advanced user to optimize the system for different applications. Small particle applications benefit from
a smaller aperture (better signal to noise ratio) and large particle or high sample flow rate applications
benefit from a relatively larger aperture size. The iris size can be adjusted using the lever. It is
recommended to only make this adjustment when running calibration beads (e.g. 1um) and viewing the
image on the flow cell camera.
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Lever to adjust light
scatter aperture. View
camera image while
adjusting. Smaller
aperture gives better
signal to noise ratio,
larger aperture gives
better high flow rate
data precision (CV).

v

w
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3. Technical Overview: Fluidics

The fluid system is designed for bio-safety, simplicity and reliability. Sheath fluid is driven by a regulated
vacuum pump. Sample is delivered to the flow cell by a high precision syringe which allows the software to
calculate the absolute number of particles (events per microliter).

3.1 Fluid System

The instrument can be fitted with a choice of fluid systems: A closed loop “Long Life” fluid box or a refillable
tank.

The layout of the pumps and valves differs between the A40, A50 and A60 generations of the cytometer.
The AB0 layout is identical to the A50 layout except that the fluidics in the A60 generation is located at the
front left of the cytometer instead of the back right. See images below.

A40 Fluidics

Cleaning
fluid
valve

Pressure
sensor

Flush cup
fill valve
(shower
valve)

Air filter
(hydrophobic

Air pump
(vacuum)
cup Syringe
pump Valve
(shower
pump)

Waste
Reservoir
(“Phase
Separator”)
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3.1.1 Closed Loop “Long Life” Fluid System

If the instrument is supplied with this type of tank, connect
the tubes and the electrical cable following the labels on
the instrument and on the connectors.

Always turn the machine’s power off before connecting or
disconnecting the fluid box / tank.

The machine will give an ‘Out of Sheath’ message on the
instrument’s display when the tank reaches its end of life.

After changing the tank, turn on the machine and allow it
to initialize. Select “New sheath” from the machine’s
display options before running your samples.

With this system no operator intervention is required until its
internal sensor detects the end of life.

At this time the operator is given an “Out of Sheath” message on the instrument display because the fluid
box can supply no more sheath fluid. When this happens, shut the machine down, replace the fluid box
and dispose of the old fluid box according to local regulations, bearing in mind that its contents are likely to
contain hazardous biological and chemical material from the samples run.

After fitting a new fluid box, select ‘New Sheath’ from the instrument's display to properly prime the system.

The long life fluid box can be ordered as a pack of 4 boxes: Apogee Cat#1422.

Sheath Cleaning
fluid filter fluid filter

3.1.2 Sheath Fluid and Cleaning Fluid Filters

The fluid filters have their inlets connected to the fluid tank by tubes
which pass through the side panel. The location of these filters varies
between flow cytometer models. The cleaning fluid filter typically
lasts more than 6 years. The sheath fluid filter should be changed if
there is an elevated amount of sheath fluid dirt measured by the
machine when running filtered water, or every 3 years.

The sheath fluid filter of the type shown in the photograph is
hydrophobic so it will not allow the flow of water if it fills with air (refer
to section 11.5 for test and wetting procedure).
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3.1.3 Refillable fluid tank

| BEEREE RV EAA A
WV @V VY Y

The refillable fluid tank requires the use of an external waste tank.

Sheath fluid reservoir lid

Cleaning fluid reservoir lid

Sheath fluid connector

Cleaning fluid connector

Fluid level detection cable

To install the refillable tank:

e Fill the sheath fluid reservoir with deionized, filtered water or with other Apogee approved sheath
fluid. Add 200u! of Proclin 300 (Supelco) as a biocide to discourage growth in the water. Use treble
the normal dose of biocide if growth is suspected or if growth has been detected within the past 2
weeks.

e Fill the cleaning solution reservoir with Apogee cleaning fluid (Cat# 1519) diluted to the
concentration on the label (typically 30%)

e Connect the cleaning solution reservoir and the sheath fluid reservoir to the appropriate machine
hose connectors.

Connect the level detection cable to the machine’s cable

e Check the waste tank is empty and connected.

e Turn on the machine and allow it to initialize.
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3.2 Autosampler Module for 96 well plates (Optional)

This optional module allows automatic sampling from 96 well plate format wells or racks of _tubes. It
requires software with Work List functionality. The hardware has sensors to make sure the cover is closed
before it operates and sensors to detect failures of the sample aspiration tube movement mechanism QUe
to a poorly positioned sample rack or some other fault condition. Refer to the "Autosampler Operation”
chapter of this manual for further information.

- I
SN FEOENIEAN XD DEEE EEf S W @R f
o = 9|
LSS Peski OX | LASPek O X |_FLI[Pesk] s
e i At |
- gy = === ‘
2 <] 2 |
S S
< 1 < <
- 4 —— - +« |
3
3 2 Sy '
5 sas ws © FL1 Threshoids & Lesen | Notes |
o 1024 1024 r 1024 T T
1.CVe0 0 Eventy=0 Mean=0 [ Cortrol [Service [ Gan [ PMT
L Fzpet OX | Fapek O T
g0~ (Ao *:] (Amaaar) | PushCycles 1
. | Jhe =] ‘ W f
i 5 e =
e 2 1 | SAMPLE 272 - |1
& < < ‘
” . ; Dasen
2 2 2 | sHEATH 22 mbar
3 v ol
2 3 FL4 DATA
- 102 o 1024 r 1024 | Total Ssec
5 ‘ evie/d [} ]
oy \Worklist
e o evis/s [ 0|
1
Choose Rack type | 96 Wed Plate v | Folder Name C'\Users\OJK\Desitop FAllFIFOs 0 Evtrate 0%
Sample ID Colsr Row  Description
1245 1 [v[A [+]semple 1
> Em: 2 |v|A |v|Sample 2
23456 3 |v|A |+|sampie3
78501 {4 |~]A |+|Sampie s
A |~ |Sample 5
=
STATUS: Idie Cean I

\ Work List
Samples must be given an ID, a location and must be Queued in order for
them to be processed.
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4. Technical Overview: Data Acquisition
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The height and area (integral) of pulses from the photomultiplier tubes are measured using high
performance analog-to-digital converters (ADCs) giving 18-bit pulse height resolution and 26-bit pulse
integral (area) resolution. This is sufficient data resolution to allow gain factors (linear and logarithmic)
to be performed in software thus avoiding the errors that would be introduced by electronic gain
circuits.

4.1  Gain Settings

Fine adjustments to gain and subtraction settings do not have to be made until after the sample has been
run, and the data stored - these settings can be applied at a later time, without the machine connected.

Of course, if you prefer, gain and subtraction settings can be adjusted during the sample run, but it is often
useful to be able to make adjustments at a later time, and the software makes this easy.

Data can be stored with or without gain and subtraction settings applied to the data.

Linear software gain factors are a useful complement to the histogram ‘Zoom’ function (available by right
clicking on any datagram).

4.2 PMT Voltages

The PMT Voltages determine the gain of the photomultiplier tubes: the number of electrons release per
photo of energy reaching the photocathode. If the Voltages are set too low the signal to noise ratio will be
worse. If the voltage is set too high the PMT tube output may saturate. To prevent saturation of the PMT
tubes, keep the PMT Voltages low enough for the PMT Noise levels to always be less than 1.00.

4.3 Event Rates and Severe Coincidence

There are three reasons why the cytometer counts:

1) A particle passes through the laser and gives a signal greater than the trigger
threshold

2) The trigger threshold is close to system noise and a tiny noise fluctuation has
caused the voltage to pulse momentarily above the trigger threshold

3) The sample is causing severe coincidence (AKA '‘Swarm' effect) where there is a

stream of concentrated particles in the laser; multiple particles in the laser at the
same time. In this case a dilution of the sample is necessary or a dramatic
reduction of the sample flow rate.

If the source of the particles is (1) then the event rate should be roughly proportional to the sample flow
rate (assuming the event rate is well below the electronic limit)
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If the source of the particles is (2) then the trigger threshold should be raised to eliminate the noise or keep
itto a low level. This type of event will continue to occur when running a sample of water. If the noise ha;
increased (a deterioration of the optical condition of the machine) then you should see that as a change in
the PMT noise levels (PMT tab of histogram software). To make sure the noise values are correct, change
any of the PMT Voltages by, for example, 1 Volt and wait a few seconds for the noise readings to update.
This forces the system to read the noise levels, otherwise the noise levels may not be current.

Sometimes the noise readings can be misread but if you repeat the process of changing a Voltage by 1
Volt several times, the true value will be apparent. A small change in the noise level will cause a massive
change in the event rate if the trigger threshold is close to noise.

Itis therefore possible to establish (by changing the sample flow rate or running water and by monitoring
the PMT noise readings) the source of events: genuine particles, optical noise (either background light
level or severe coincidence effect).
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5. Display Panel (A20 Military model only)

Instrument status

Last instrument operation

Press button for additional
commands (e.g. for automated flow
cell clean)

Display buttons

Instrument power button (only use after
performing a ‘Shutdown’ of the fluidics)

Display contrast button

An instrument display can be installed to display basic instrument status information. If specially
programmed, it can also be used to display information about populations of particles in the samples
(‘stand-alone’ mode).

Under the display there are 5 green buttons. These are not normally needed because all functions can be
selected from the histogram software.

Most models do not have this type of display because all settings and data are accessed via the histogram
software on a separate LCD monitor.

5:1 Commands available from the Display Panel

FLUSH
Flushes (cleans) the sample tubing. Ensure the sample arm is in the flush position.

RUN
Runs a sample. Ensure the sample arm is in the run position and sample is available in the test tube. It is
not recommended to allow the system to suck up air instead of sample.

SHUTDOWN - Normal / Cold Shutdown
Selecting 'Shutdown' and then 'Normal' performs a Flush, delivers cleaning fluid to the flow cell and
prepares the machine for turning the power off.

'Cold Shutdown' is for storage of the machine in temperatures below 5 degrees Centigrade. A special fluid
box (containing antifreeze) is required for this operation.

NEW SHEATH
Select this command each time you change the fluid box (long-life, ‘closed loop’ fluid box). It runs a various
fluidics cycles to remove air from the sheath fluid system, and to flush through the sheath fluid tubing.
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MORE CMDS
Displays additional commands, e.g. ‘Flow Cell Clean’

FLOW CLEAN

Delivers cleaning fluid to the flow cell, lets the flow cell soak in cleaning fluid for approx 40 seconds and
then flushes the sample tubes and flushes the cleaning fluid through the flow cell.

INIT

This command performs various cycles to prepare the machine for the first gample of the day. If the .
machine is configured to run in Stand-Alone mode then a Calibration (CAL) is automatically performed a
the end of this Initialization routine.

CAL

Pressing “MORE CMDS" followed by “CAL” toggles Calibration mode on/off. Loyt
The machine is in normal sampling mode when “RESULTS:” is displayed on the LCD, and Calibration
mode when “CALIBRATE:" is displayed on the LCD.
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i ? 6. Cytometer Setup

- % Choose a safe location for the machine with at least 20cm of ventilation space behind the ma'chine. The

! instrument’s two fans (back panel) require 20 cm of ventilation space; otherwise the machine’s processor
l D may overheat causing the instrument to shutdown without fluidics cleaning cycles.

=3

g 6.1  Unpacking

g 2 . .
l The system should be unpacked and installed by an ApogeeFlow trained employee or local representative.
o See section 11.6 for repacking instructions in case the system needs to be transported.

[ 3

¥

6:2 Instrument Back Panel Connections

-
The instrument can be run either:
=
1z Connected to an external PC.
2. Using the internal PC for data analysis with an external monitor, keyboard and mouse

connected to the back of the machine.

A PC, running Windows is built into the machine, so no external computer is required. However, an
external PC may be configured if LAN security demands.

Set-up for Histogram Data Analysis Using Internal PC
1. With the power off, connect a monitor, mouse and keyboard to the
connectors on the back of the machine.

2. Turn the power on and wait for the operating system and FCM Control
software to boot up.

u
w

Allow the machine to initialize.

Lt
£

After the initialize cycle has finished, the machine is ready for a sample. Run calibration beads to
check instrument operation.
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LAN cable
connection

Using an External PC for Data Analysis and Storage

Use of an external PC is possible if LAN security
demands.

Communication between the external PC and the
machine is via a standard LAN connection. To connect
the external PC to a LAN, a second network card is
required.

The network name of the cytometer's PC is set in the
factory to ‘Axxxx’ where xxxx are the first four digits of the
instrument serial number.

The instrument’s IP address settings will normally be sent
with the machine. Alternatively they can be found by
connecting a monitor, keyboard and mouse and using the
Windows operating system (Control Panel—Network
Connections etc.).
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i 6.3  Network Configuration
“ P
l A network connection may be established with the cytometer to take advantage of the following features:
[
e Use of remote desktop software to administer, service and diagnose the cytometer
[ e Data collection and instrument control using the Histogram Software running on an external PC
I e Transfer of datafiles AutoSaved to the cytometer’s internal disc drive
[ Y
!: 2 The cytometer can be connected to a local area network (LAN). It can be configured with a ﬁxed_ IP
address or the IP address can be DHCP assigned. This is configured using the Windows operating
3 system.
[ ) Important notes: - Local Area Connection Properties
= (f B 3 ‘ ;
= e All network connections must General | Authentication | Advanced
be established BEFORE the Bt
cytometer’s ‘FCM Control’ - |
software starts. So connect the HB Broadcom 440 10/100 Integrated C i
3 network before turning on the ]
6 lr?tahc:llgg & CoatiglirEdlin This connection uses the following tems:
connect to a network with 12 QoS Packet Scheduler o
special security settings, %= AEGIS Protocol (IEEE 802.1x)v22.1.0
consult the network ¥ Intemet Protocol (TCP/IP) =
administrator. Some network b
security systems may block < e e 3

communications between the

Histogram Software. | Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

Show icon in notification area when connected

Appropriate network settings will usually
Notify me when this connection has limited or no connectivity

be made in the factory. To check or
change the network settings, go to the
properties of the network connection:

L 0K ] LCancel ]

Scroll down the list of items, choose Internet Protocol (TCP/IP), and click Properties.

=
=2
=
e
=
3
=
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If the machine is being used on a LAN
with a DHCP server the cytometer will
obtain an IP address automatically.

If the machine is being used on a LAN
without a DHCP server (for example if the
machine is connected directly to another
PC with a ‘twisted’ network cable, or via a
network switch or hub) a fixed IP address
must be used.

INFORMATION
T OCUMENT CONTAINS CONFIDENTIAL
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Internet Protocol (TCP/IP) Properties

(Gerel | et Cotpton]| i

i vork supports
You can get IP settings assigned automatically if your netwo
this capability. Otherwise, you need to ask your network administrator for
the appropriate IP settings

(3) Obtain an IP address automatically
(O Use the following IP address:

(®) Obtain DNS server address automatically
(O Use the following DNS server addresses:

| Advanced
|

e flae e e L

[ ox ]fa;c;J

)X
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When using a fixed IP address for the cytometer,
192.168.82.40 is often used.

The IP address of the PC which you intend to use
to connect to the machine, must be set to a similar
address, but different. For example 192.168.82.41
as shown below:

THIS DOCUMENT CONTAINS CONFIDENTIAL INFORMATION
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Internet Protocol (TCP/IP) Properties @@

General | L

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator for

the appropriate IP settings.

(O Obtain an IP address automatically
(® Use the following IP address:

P address: [192 168 . 82 . 20 |
Subnet mask: 255255255 0 |
Default gateway: WAl o ]

(® Use the following DNS server addresses:
Prefemed DNS server: .

Altemate DNS server:

Internet Protocol (TCP/IP) Properties El@

General |

You can get IP settings assigned automatically if your network supports
this capabilty. Otherwise, you need to ask your network administrator for
the appropriate IP settings.

(O Obtain an IP address automatically
(®) Use the following IP address

IP address: 192 168 . 82 . 41 |
Subnet mask 255 .255 255 0
Default gateway: = a '

() Use the following DNS server addresses
| Prefered DNS server: '

| Alttemate DNS server

l bK 1L Cancel }
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If fixed IP addresses are used as above, without a DNS server specified, it may not be possible to use the
network name of the machine to access it. Instead the machine’s IP address should be used.

In the histogram software’s User Configuration program, the IP address can be entered instead of a

network name as shown below.

| & Select Apogee Flow Cytometer
{ General Settngs  Channel Settings

\lfa:”*" 2 Auto-Lymphocyte Option

(SR ) Not bnstaled Baad O Count/id [ ]
| Lcense Key set Tolerance (%) - «_J
|

(RO! name: 'BeadQirl)

Connection Lasers il Datafie Pameters
| O Comectio FCM sDO1 [288 Laser 1 Max Power (200 | mW o7  [MICRO& ]
| © moaso SDO2 [405 | mer2MmPower 1 | mW  CYTSN[OJKLsstopd |
| [s21s88240 v SD03 (638 | Laser3MaxPower

Laser & Max Power [0 |

User |Levell
Fie Load includes Sheath Pressure. PMTV & Subtr
Software Control Panel - AVAILABLE.
Instrument Control Tab - AVAILABLE
Sampie Flow Fate Control - ENABLED
Sheath Pressure Control - ENABLED
Service Tab - AVAILABLE
Subtraction Tab - AVAILABLE
Gan Tab Page - AVAILABLE
Threshold Tab - AVAILABLE

PMT Tab - AVAILABLE

Setup option on man menu - AVAILABLE
Fie Load includes Sample Flow Rate
File Load inciudes scftware Gan setings.
Fie Load includes Threshoid settings
Datagram setup menu - AVAILABLE
Seff Calibration Button - DISABLED
Papulation detection mery - DISABLED
Mrwmized Windows - ENABLED

www_ApogeeFlow com
20 April 2020

Page 30 of 80

Doc# 16004, Rev 2 43

CAARARAARARAARAARARARAAARANRAAAARARARARANAAARRARANADSR



\
“1

RV
¥

'm
~

|
|

AwaAENVERTE
vV v

B
i

-

T

-

TV

THIS DOCUMENT CONTAINS CONFIDENTIAL INFORMATION

i ! DO NOT DISTRIBUTE OR COPY WITHOUT PERMISSION

FLOW SYSTEMS

7. Apogee Software

The machine’s hardware is controlled by a program called ‘FCM Control’ which runs on the computer
inside the cytometer. It runs in the background and requires no user interaction.

Software for collecting the data in industry standard FCS format and for viewing the data on histograms
can either be run on a separate PC connected by Ethernet link, or on the internal PC. This histogram
software comes with a User Configuration program.

The FCM Control program requires permissions and drivers to talk to the electronics and transmit data to
the Histogram application. The FCM Control program is factory configured and no operator interaction is
required.

The Histogram application talks with the FCM Control program via TCP/IP. The address or network name
of the cytometer PC must be entered in the User Configuration program to allow the Histogram app to
connect to the FCM Control program.

The software is installed in the factory so does not need installing by the operator but section 7.2 below
explains how the Histogram app may be installed on separate PCs for convenient data analysis, avoiding
the need to use the cytometer PC.

7.1 Multiple Windows User Accounts and GxP Mode

7.1.1 Multiple Windows User Accounts & Permissions

To configure a new Windows User, set the new user as an Administrator to start with. Run the
programs “Histograminitialiser.exe” and “HistogramUserLicense.exe” when logged on as the new user
(with Admin permissions). Make sure the Histogram application runs and set the default file folder when
prompted when the application runs for the first time. At this time it is helpful to set the Autosave folder
via the WorkList header button.

Only once the Histogram application has been run as a genuine Admin user can the user’s permissions
be reduced to a Standard User. See section 7.2 below.

To control the permissions = e

of each Windows user, L
each user's Windows name et
should be entered into the

User Configuration o
program and a User Level e -y
chosen. Access may then

be restricted to the User T
Configuration program (for R T R ~ it
example by deleting the o e ‘ e ey
program shortcut and/or -
the executable file) so that L }
unauthorised users are o -
unable to change the User ! \ -
Level. The list of ,

permissions and the User o om0 e
combo box control allow you to see the permissions for each user level.
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Windows 10 requires the FCM Control application to be run with Admin permissions for it to :
communicate with the Autosampler electronics. To talk with the FCM Control application the H|§togram
application may also need administrator permissions. If so, for Standard Windows users, the Histogram
App can be run with Administrator permissions by creating a shortcut with the following path:

runas /user:A0999\ApogeeFlow /savecred “C:\Program Files (x86)\Apogee\Histogram.exe”

where:
e A0999 is the computer name
e ApogeeFlow is an administrator user

The first time this shortcut is used the user is asked for the administrator password and a Windows
credential is created (refer to Windows Credential Manager).

The Histogram application will then run with the user level assigned to the administrator (in this case
ApogeeFlow). It is therefore normal to create an Admin account for use by the Standard users and with
Level 3 permissions set in the User Configuration program.

o x [} el ¥

7.1.2 Data Integrity: $ORIGINALITY, $OP, Acquisition
Date & Time

The Windows user name is saved in the FCS file with the $OP "':,""‘ .
keyword. In this way the original operator is identified in the FCS file. P —
The user can be found by opening the Summary Information dialog if oo
from the EDIT button on the Info tab of the Histogram Software. L ' | B
When a datafile is saved using the WorkList Autosave feature, the S
$ORIGINALITY keyword is set true to indicate the file has not been j
tampered with since the data was acquired. If a file is saved (or re- S

saved) in another way, the $ORIGINALITY keyword is set to false. The exception to this rule is when
“User Level 3 — 21CFR Part 11” is active (see section 7.1.3). When a file with true $ORIGINALITY is
opened, the words “AutoSaved Original” are displayed below the SamplelD on the Info tab.

The date, time of the data acquisition and Windows user name are et o

also saved into the FCS file and displayed on the ‘Info’ tab of the —

Control Panel and in the Summary Information dialog. Aol
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7.1.3 GxP Mode (User Level 3) for Regulated Environments

The Histogram application may be operated in a mode essentially compliant with part 11 of Title 21 of
the Code of Federal Regulations; Electronic Records; Electronic Signatures (21 CFR Part 11). This

option is offered as ApogeeFlow product # 8057. The Histogram application GxP module requires the
system be configured by a service engineer.

Operation in GxP mode requires Windows Users to be set up with appropriate Windows security
permissions and each user's operating permissions must also be set using the User Configuration

program (see section 7.1.1). Instrument operators should be set to work under User Level 3. Laboratory
administrators may be configured with User Level 1.

oy S———

The User Name column is for Windows User : - o
Names. With User Level 1 the user has full
permissions.

The 'normal' / routine operator User Level
should be set to Level 3 which is for the GxP
mode of operation (limited permissions).
After creation of a new Windows user
account, when logged on as that new user,
the Initialiser app and the User License app
must be run to allow the Histogram app for
execute. These apps will be provided to the
administrator.

When Histogram app is running under User Level 3, the Calibrate button and calibration status
indicators are displayed on the Control Panel. To run a calibration you can use the Calibrate button or
type a Sample ID beginning with the characters “ApoCAL”, then press F10 or click the Run Button.
When the ApoCAL sample runs with the machine in Calibrate mode, the software algorithm looks at the
shape of populations in two dimensional regions and assesses the number of particles in any
populations identified in each region. If the results from each region meet requirements defined in the

FCM Control program, the system’s calibration status is set to “CALIBRATED" at the end of the sample
run.

Detailed calibration results are shown in the FCM Control Window as the sample runs and are saved in
a log file to allow long term monitoring:
C:\Users\Public\Documents\Apogee\CalibrationLog.txt
For service engineer use, technical data from every failed calibration is stored in file:
C:\Users\Public\Documents\Apogee PC Control\logError.txt

While running a calibration sample (during the calibration sample data acquisition), when the software
detects a population in one of the internally defined regions it compares the brightness of the signals
with internally defined target locations and automatically adjusts the photomultiplier voltages if the
population is not in the correct position. After each such calibration of the signals, the FCM Control
program sends a command to the Histogram application to clear the screen of data and continue
analyzing the calibration sample with the new photomultiplier voltage settings. The small adjustments
made to the PMT voltages "calibrate’ the signals so they are the same strength each day. If the software
deems a large voltage change to be necessary the calibration will fail.

The calibration status changes to GREEN if the calibration is successful or RED if it fails. The
calibration status is stored in the fcs datafile. The calibration will be set to expire after a defined interval,
typically 8 hours.
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Once calibrated, the user may run their samples, but they cannot generally change instrument settirjgs:
they must load a predefined settings Protocol file from the File--->Settings menu option or by selecting
a protocol in the WorkList.

Administrators should be aware that:

e The list of protocols is a list of the fcs files in folder “C:\Program Files (x86)\Apogee\Protocols”.
An administrator (Level 1) user must define those fcs protocol files for use by all users.

e The User Configuration application should be deleted from non-Administrator users’ desktop
and Start menus.

e Alocal network administrator should limit write permission to avoid Standard Windows users
editing files in folder:

C:\Program Files (x86)\Protocols

The typical operation process is provided in section 8.1.2 and summarized here:

1. Turn on machine and log in to Windows.

2. While waiting for the machine to “Initialise” (approx. 5 mins), click the AutoSave path
button in the WorkList header and create a new folder for this session’s data.

3. Inthe WorkList, enter the SamplelD “ApoCAL” for the ApoCAL test bead sample (or load a
pre-saved WorkList)

4. When the machine is ready for a sample (green indicator on Control Panel), press F10 or

click the Run button and wait for the system to calibrate (approx. 2 mins). Make sure the

calibration is successful. The data will save automatically to the AutoSave folder when the

sample stops.

Load a template suitable for the biological samples to be analyzed.

Enter SamplelDs in the Work List, these IDs will be used for the fcs file names

Run the biological samples. Each sample will automatically save when it completes.

At the end of the session, run an ApoCAL sample to verify the condition of the machine

Run a sample of 10% bleach to clean the sample tubes.

0. Run samples of pure water until the event rate is low (typically <250/sec) indicating the

machine’s sample and sheath tubes are clean.

11. Click Shutdown. The machine will perform cleaning cycles and turn itself off after about 5

mins.

=(0100 N 0¥

This mode of operation is recommended for use of the flow cytometer in a GMP or GLP environment.

In this mode of operation user permissions are limited and an encrypted Audit Trail file is maintained:
C:\Users\Public\Documents\Apogee\Audit.bin

The name of the settings file and all changes and actions made since the last loading of a settings

template are recorded in the Audit Trail. The Audit Trail allows users to make certain changes to the

datafile (e.g. ROI position changes) without invalidating the SORIGINALITY keyword.

See section 8.1.2 for information on the ApoCAL automatic calibration.
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7.4  Histogram Software

Th_e histogram software displays the data from the samples, and allows all the instrument settings to be
adquted. This software is used to read and create data files containing ‘list mode’ data and instrument
settings. Files are stored in the industry standard FCS format.

Control panel

Menu bar Toolbar

Title bar

#1 Apogee A40 Flow Cytometer - [SampleDrt-.DefaultA40.fcs]
Fie Edt Vew Control Setp Window About

2|3 |Qeg] @98 e |=|a)] | x| L|Lfel] - £a| Blelex

i1 151 [Peak] - Light Scatter  [STET|F iu' Fit joeai] " Filioisstineens & LS2 [Paak]
Ao w| Ao v
ok ° 9
a| 2 E Fush 1 = count
2 H f =
3 H 3 Sample Flow Rate
of:
: 9 kg 21 v| wmn
Sheath Pressuse:  Vokame -
I R |
Acqustion
LA 20aL Avenge Tt Swec
cts/id [ 0
‘ ciafsec o ]
el L s = Dison Factor 1
1 CAL CV=0.0 Events=0 Peak 0 Means0 Evt/ud=0 R | |2 CAL CV=0 0 Events=0 Pesk=0 Mean=0 Evt/ui=0 R
FLD [Peak] B (o] <|| G of x|| TR
Ao v Auto ¥
E 1T 1 ctages Backgrmund
2 2 g o
b 3 3 st 50 = oo
2 [ |
o o o |
FL1. (700 _‘: om I
Az 0 =+ o
A 0 4 |
e @ = |
|
|
FL2 3 FLg |
6553% 65536 65536 |
1
Apogee FCM Control Software - Developed by Apogee - AutoRefesh Dosbled 2 State: Faded To Corect  Discornectsd |
Status bar

7.4.1 The Title Bar

The name of the last saved/loaded data file is displayed in the title bar. In addition, on the right part of the
bar, there are three buttons to minimize, maximize/restore and close the software window.

oo A0 [ low Cytometor  [SampieData\DafanltA40 fes)

Minimize
Datafile name

Maximise /
Restore

Close
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7.4.2 The Menu Bar

The menu bar contains all the main ‘drop-down’ menu options.

Apogee A40 Flow Cytomeler - [SampleData\DefanltA4D.fes]

o ] L] ][] e 9

i@

1 C\PROGRA~I\...\DefaultA40
| 2176_200_270nm_LightScatter

3 scatter_sensitivity

4 M4_1B1S

Ext

7.4.3 The Toolbar

On the toolbar, the most frequently used commands are easily accessible. Just click on one icon to select
the related command.

2@|@IE| &% B o] 0| =[a] »|x| Ll ||| La| B2

When the mouse pointer rests above one of the icons, a tool tip will appear, indicating the command
connected to the icon. In addition, it is possible to see the same indication on the status bar at the bottom
of the screen.

File Edt View Control Setup Window About
215(0(e5| &/ 8 o1 =|8] vl X| LIl |- || Sl @2 (o]

Repla C| L FL1[Peak]

L 151 [Peak]

Tool tip
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7.4.4 The Status Bar

The status bar informs the user about the current status of the instrument. For example: “Running”,
“Flushing...”, “Move arm to flush position”, “Shutting Down”, “Loading new sheath”. If the auto-
calibration software is installed, the instrument calibration status is displayed here.

Status bar \

Task bar

7.4.4.1 Description of Software States

IDLE
There is normally a slow (gravity) sheath flow to keep the fluid system clean.

Flushing

Cleaning sample tubes using the syringe to push sheath fluid through them, also cleaning outside of the
sample aspiration tube by filling flush cup with sheath fluid.

Shutting Down
Flushing sample tubes with sheath fluid and cleaning fluid. Cleaning the flow cell with cleaning fluid.

Fluidics Fault

Fluidics cannot reach the normal pressure across the flow cell, e.g. due to blocked sheath fluid flow, faulty
vacuum pump or pressure sensor.

Calibrating
The machine is self-calibrating. The calibration will typically take 100 seconds

Calibrated

The machine has passed the calibration test. If the user changes the PMT voltages it will void the
calibration.

Uncalibrated
Either has not been calibrated, or user has manually changed the PMT voltages.

Cal-failed
The machine failed to meet the calibration requirements. Refer to the Troubleshooting section
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7.4.5 The Control Panel

7451 Control Tab

This tab is the most frequently used tab.

L ERIEATE

ul/min

sampLe [195 ~[[1%0 -]

W‘

SHEATH l ]mbar

DATA SR
Total 5sec {

evis/ul 0 0

evis/s % 0N

Full FIFOs 0 Evt rate 1502\

A

\ N

1

pal

Auto-Lymphocyte Results l
Ncges
Gan | Threyhold  PMT l
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The main instrument settings are accessible from the control panel. If the Control Panel is not visible,
click on the View menu and select the option Control panel. The Control Panel is designed to make
the most commonly used settings easily accessible. On this panel several tabs are present.

Run a sample (same as green button display option). Not normally gsed
because samples normally run automatically when the sample arm is
moved to the run position.

Stop the sample and flush (same as green button display option). Make
sure sample arm is in flush position.

Set the number of sample tubing flushes performed when a
flush command is given. If > 4, a rinse operation is also
performed.

Set the sample analysis rate

Set the volume of sample sucked up. Note that approx 80ul of sample is not

used, so with volume set to 130ul, approx 70ul will be analysed.

Set the sheath flow rate (speed at which cells travel through the flow cell).

Counts per micro-litre dilution correction factor. This is useful
if your sample has been diluted by reagent or buffer, and you
want to automatically correct the cell concentration displayed
by the software. Set this on the Page Setup menu.

\ Average events per micro-litre and events per

second for the last 5 seconds

\ Events/ul and Events/sec average for all data in the memory buffer

Event rate stability monitor. This is the % difference between the
average event rate at the current time, and the event rate during the first
30 seconds of the sample. Normal range -20% to +10%. An air bubble
in the syringe can cause variation.

FIFO Full warnings. The number of FIFO overflows which are the
normal cause of lost data due to the event rate being too high for the
computer. Use thresholds to eliminated unwanted events to keep the
event rate down and ensure no events are lost
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! 2 7.452 Subtraction (Fluorescence Compensation)
! » Fluorescence subtraction settings may be accessed using the button on the PMT tab of the Con?rol
' g Panel, or via the right click menu option on a cytogram with two fluorescence parameters. The dialog
- allows the setting of spectral overlap compensation (‘subtraction’). This is useful when multiple
. fluorescent markers, with overlapping [ Prcrsconcesbtacion - - o x
fluorescence emission spectra, are used. Rt s S S e e S i Mt
; =9 405Gm 450 628Red £330Red 433Gem 4380 435 Red
From po 00 % 00 00 % 0 & 00 5
2 Data in the buffer automatically ‘replays’ after ; i g wE o
3 changes to the subtraction values. Make sure | “:" s = -
i the 'Apply Settings on Replay' option is ticked o
= 5 on the Gain tab (also accessible on the Setup TR & L2 ?
'“ menu). fon 00 3] 00 [
This dialog box can be left open while you test | <& = :
D a variety of values (there's no need to close it b (0F (O (O (0F
each time you change a value). e e ;
:‘3 . ' : 483 Fed
The subtraction principles are the same as for fom
¢ 3 any other flow cytometer: v =]
1) Run a sample of cells or beads without fluorescent markers. Create fluorescence histograms

gated on the light scatter cell/lbead population. Position ROls around the negative cells on the
fluorescence histograms. Record the mean fluorescence intensities (MFls) of the negative cell
population.

2

2) Run the cell/bead sample labeled with one fluorochrome at a time (one sample for each
fluorochrome) and save the data.

T2

3) The fluorochrome emission should fall mainly in one
fluorescence detector (this depends on the fluorochrome FL-1 FL-2
spectra and the fluorescence filters installed in your
machine). Let's call this the ‘fluvorochrome detector’.

Lo

4) For each single fluorochrome datafile, check the MFI
of the cells on the other detectors (not the fluorochrome
detector). If the MF| has increased it must be due to
fluorescence spill-over from the fluorochrome, so adjust the
appropriate control to subtract a percentage of the signal on
the fluorochrome detector from each of the other channels ®
where there is spill-over. You should end up with about the

same MFI values as you recorded when no fluorescent label
was used in step (1).

Fluorescence

¢ e

Note that the fluorescence subtraction values are dependent on photomultiplier voltages.

o &

PROCEDURE

The user may be supplied with a set of datafiles to facilitate the compensation process, or they
can create these template files themselves, for example:
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COMP_UNLABELED.fcs

With cytograms or histograms for each fluorescence detector, gated on the cell population as
measured by light scattering. Each cytogram should have an ROI which can be used to record
the mean noise of the unlabeled cell population measured on each detector.

COMP_FITC fcs .
With cytograms displaying FITC on X axes against each other fluorescence detector on Y axis,
with ROls on the cell clusters to give the mean fluorescence from the Y parameters

COMP_PE.fcs
With cytograms displaying PE on X axes against each other fluorescence detector on Y axis,
with ROIs on the cell clusters to give the mean fluorescence from the Y parameters

COMP_Cys5.fcs
With cytograms displaying Cy5 on X axes against each other fluorescence detector on Y axis,
with ROIs on the cell clusters to give the mean fluorescence from the Y parameters

A0 000

COMP_Cy7 .fcs
With cytograms displaying Cy7 on X axes against each other fluorescence detector on Y axis,
with ROIs on the cell clusters to give the mean fluorescence from the Y parameters

1) Load COMP_UNLABELED.fcs and Run unlabeled cells

2) Decide on PMT Voltages for the fluorescence detectors. These are typically simply the
voltages stored in the template file. It is normal to keep the cell clusters below the 1000 position
on a logarithmic axis (22 bit scale).

3) Record the mean unlabeled cell brightness (histogram bin) values for each detector. This is
the Mean ROI statistic for the unlabeled cells.

4) Save the unlabeled cell data for future reference if desired.

5) Load or apply a settings file suitable for the color you want to compensate (e.g.
COMP_FITC.fcs). Make sure the fluorescence PMT Voltages remain the same because the
voltages affect the subtraction values.

6) Run a first sample labelled with only one fluorophore (e.g. FITC) and make sure the
AUTOCOMP ROls are well positioned to capture all cells

7) Save the data if desired.

8) For each cytogram right click and choose ‘Subtraction’ to display the Subtraction window.

Increase the subtraction until the MeanY statistic equals the noise value for that channel. The &

data will replay after each change to the subtraction value. Record the subtraction value found.

Alternatively, for extra speed it may be possible to anticipate the amount of subtraction required (-

because: I
€ :

Beware of overcompensation which will put too many events against the axis because negative

values due to overcompensation are all put into the first histogram bin &

9) Repeat for the other fluorophores by looping back to step (5) until all fluorophores are &

compensated
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The subtraction settings are stored in the fcs file but beware that if you load another FCS file the
L subtraction values will be taken from that new file. To analyse a session’s datafiles with new
subtraction values, use the ‘Load Data Only’ option.
iy )
L 5 Control Panel 2
r@ 7.4.53 Service Tab =
B This dialog box is accessible only if the Level 1, 2 or 3 has Bush St
— been selected in the User Configuration software. ]‘
] A
‘Load New Sheath’ pumps lots of sheath fluid through the system Throshokde § Lasers o L ]
to clear any large air bubbles. It must be clicked whenever the Corsol % [
machine detects and empty sheath tank. HG/LE Cobraions ;
® Peak O Aea [
‘Remove Air in Syringe' is a useful button for occasional use (once s BB ]
a month). This moves the syringe piston slightly out of the o
precision glass syringe and allows sheath fluid to expel air from NS 0 ;
the syringe. Air in the syringe affects the accuracy of the sample
system because the volume of trapped air changes a lot with 1 T
pressure. The operator should perform this operation if they :
suspect inaccurate evts/ul readings. The button is enabled when i 0 & |
the machine is connected to the histogram software and the L3 0
machine is idle. FL4 0 =
The “Flow Cell Clean” button draws cleaning fluid from the tank
into the flow cell and sample tubing. This is automatically
performed during the Shutdown cycle.
The “Flow Cell Soak” procedure should be used to address high
light scatter PMT noise levels. It draws cleaning fluid into the flow
cell and leaves it there for approximately 10 minutes. HG Lim %00
Load New Sheath
The following controls are not normally used ) [
The High/Low channel calibration settings should be set to 0 for Remave Ar in Syange

normal use. These settings may be used to ensure no gap or
overlap in the data at the High Gain Cutoff position on the
histogram. It can be set between -1500 and +1500 (65535 "

resolut

iution)

The HG Limit control allow adjustment of the histogram channel number

(65535 resolution) at which the data acquisition electronics switches from a :

high gain signal to a lower gain signal. This should be set to approximately _’

3500 under normal circumstances, but ¢ hanged to lower lues

there is an imperfection in the data at channel 3500 (e g a gap or overlap in data) t

imperfection away from data of interest
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7454 PMT Voltage Tab

The PMT tab is used to adjust the photomultiplier tube (PMT) voltages. For Auto-40 machines
and Stand-Alone machines, these voltages are automatically set by the machine during a
calibration and should not be altered by the user (changing them will set the machine to
‘Uncalibrated’)

Increasing the PMT voltage increases the number pf .
electrons emitted by the tube for each photon received. i.e.
the gain of the PMT tube increases when you increase the

Edt View Control Setup Window

S ﬂ L : ,E PMT voltage.
%4 Control Panel “ Larger signals are plotted further to the right on histograms,
so to move a population of cells to the right, increase the
PMT voltage.
The MiniFCM can be used to measure a very wide range of
particles. If measuring bright particles (particles which
| Auto-Lymphocyte Resus | ; scatter a lot of light or which emit a lot of fluorescence), then
| Thresholds & Lasers [ Notes | || the PMT voltage may be set as low as 200Volts. If
;»M PMT | measuring very dim particles, the PMT voltage will need to
i i be set higher.
" Yege: s As a general guide, if the noise level rises above 0.5 then
SAES 5 f 0 reduce the PMT voltage and use gain instead. This is
| LALS %0 [ 000 particularly applicable to the scatter PMT voltages because
i 1488 75 A 00 E the scatter PMTs receive a lot of background light.
| F2488 550 | 0.00
| F3-488 so0 = o000 || The background light (noise) levels reaching the fluorescence PMTs
| Fazss s0 = ooo || a@regenerally very low because the background is eliminated by the
; = fluorescence filters. It is important to keep all the noise levels to
[ 28 0[5 000 below 1.0. Lowering the PMT voltage lowers the noise.
| F6639 200 & 000
7405 500 1= 000 As a guide, the fluorescence PMT voltages are typically set in the
‘ range 350 to 750 Volts.
iz, A7 gy 000 | The scatter PMT voltages are typically set in the range 250 to 450
| na 200 |5 o000 || Volts.

na 0.00

If the scatter PMT noise levels are greater than 1.00 when 1um
calibration particles are in histogram channel 20000/65535, with gain
1, then perform a Flow Cell Soak operation, because this is an
indication of a dirty flow cell.

il If the noise levels rise above 1.00 the response of the PMT tube may
become non-linear and unpredictable threshold triggering problems

= may occur, giving misleading data. The machine should not be used
in this condition (perform a Flow Cell Soak, lower the PMT voltage or have the machine serviced).

4 Worklist %
Autnﬂn‘ruh Disabled

See the 'Subtraction' section above for a description of the subtraction dialog accessible by clicking
the button on this 'PMT' tab.
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7455 Gain Tab

The Gain tab allows setting of the linear and logarithmic gains. These gains are applied to data from
the corresponding PMT tube as it arrives in the histogram software.

To enable the logarithmic gain controls it is necessary
to click the ‘Log Gain’ option (which applies to all data

SH & & "' HE in that channel as it arrives) on the ‘View’ pull-down
'3, Control Pandl —— menu.

Ed®t Vew Control Setup Window [fl

When using logarithmic gain, if the lower (left hand side)
one or two decades contain no useful data, you should
g reduce the PMT voltage. Alternatively you can choose to
G hide the first and/or second decades.

| Ao Lymphooyte Reauts |
Control | S:v:“;"Gmgguﬁr_f The gain settings can be used to apply post analysis gain to
,r“"""‘*“ i data — simply load the data, check "Apply settings on
} Vaue  Log replay", set the desired gains (and fluorescence subtraction,
» SALS 10 & B if desired) and click ‘Replay’ on the Toolbar.
| s 0 & B
F1488 o =\ | ‘Apply Settings on Replay’ applies the current gain and
_— . | subtraction settings to the current dataset (buffer) when you
click the Replay button on the toolbar or select the Replay
F3488 10 B B8 | option on the Control menu. The actual data buffer is not
| Fa4ss w . modified, but data from the current buffer is adjusted before
| oe B | being displayed on the screen.
! F6-639 10 B B i ; d . ’
[ i & n The nge Data with Gain and Subtraction’ option
= = determines whether the current data buffer is saved before
| - s w B or after gain and subtraction settings have been applied.
j} na 10 B B8 ff
| na 0 & A

Hide Log Decade None i
| Puise Width Scale Factor (10 12/

[¥] Apply Settings on Replay
|| Save Data with Gain & Subtraction |§i

[ 1 Select ‘Apply Settings on Replay’ and deselect ‘Apply Settings
| to Stored Data’.
gy ——fil When the data buffer is saved to a file, the data is stored in the file
S M;M* [l before any Gain or Subtraction has been applied. Gain and Subtraction
= === can still be used while running samples, and Gain and Subtraction will
be apphed upon replay, but the machine will store the raw data when you choose 'Save'. This makes

it simple to change Gain and Subtraction settings after running samples.

OR

2. Select ‘Apply Settings to Stored Data’ and deselect 'Apply Settings on Replay'.

When the data buffer is stored to a file, the data is stored after Gain and Subtraction have been
applied. In this case you must deselect ‘Apply Settings on Replay’ to ensure the gain and subtraction
settings do not get applied a second time when the data is replayed or loaded from the saved file
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7456 Thresholds & Lasers Tab

Trigger thresholds are used to eliminate optical noise events and unwanted particles (e.g. debris) in
the sample so that processing power is reserved for the particles of interest.

g ol Semp w | The thresholds may be set by dragging the dotted red
SEEEgsme _| line on the histogram, or by typing threshold levels
"o Coatrol Pandd e directly into the boxes on the Threshold tab.

The values displayed are on a 16 bit scale (i.e. 1 to
65535).

F ) If thresholds are active on more than one PMT
Atohppioots feads) detector, the combination operator applies.

mfm | For example, if the AND operator is selected then a
- — i particle must give signals greater than the threshold
il SALS 3 levels for all PMTs with active thresholds, in order for it
I LALS to be counted.
F1488 If the OR operator is selected, the particle must give a
F2488 signal greater than the threshold level on any one of
3488 the PMTs in order for it to be counted.
: ::sz The trigger thresholds act on the pulse heights (not pulse integral (Area)).
F6-639

CAUTION: Avoid using very low (e.g. less than 500) scatter
thresholds unless the PMT noise level (see PMT tab) is low (e.g.
less than 0.5). If a very low threshold is used on a channel with a
high noise level the trigger circuit may not function correctly.

| [ 488 635
- Srpes CAUTION: If using AND logic, do not set any of the threshold at a level
where there would be in the instrument noise because the noise will
interfere with the triggering circuit. As a guide, when using AND logic,
keep the thresholds above channel 500 on light scatter and above
{ channel 200 on fluorescence.
“«l Worklist

AutoRatresh: Dsabied
An upper trigger threshold may also be set. The upper threshold is
disabled when set to 65535, and the upper threshold logic is always AND. In other words if any event
is above any enabled upper threshold, it will be rejected.

Depending on the types of laser installed, the lasers may turn on/off immediately in response to the
check boxes, or may require several minutes of warm-up time.
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EH Apogee Flow Cytometer - [C:\PROGRA-

»
»
)
R
3 7.46 The ‘File’ menu L Edt View Control Setup Window Abod
D Load Settings... » l .
Open Datafile (Settings & Data) Ctrl+O h
» 7461 Load Settings... i
Apply Protocol... »
(
= ] Frequently used template files may be saved to folder: S s M e
B C:\Program Files (x86)\Apogee\Protocols s B .
e Summary Info
» Files in this location will appear on the “Load Settings...” menu and are || Pao Setup and Dition Factor
common to all users. New files will not appear until the software has Print Setup
e ) been restarted. Print Curl+P
6pen WinBryte File
Open WinBryte File Data Only
Auto40 cytometers have the files in Current File Excel Export
Batch Excel Export ”CbIV+E ;
C:\Program Files\Apogee\SampleData :
And th i :
ey are typically ok
CD4 Protocol.fcs - CD4 Settings 1 D4 Protocol.fcs
CD4 Percentage Protocol.fcs - CD4-45% Settings : s
CD4 Percentage Manual Protocol.fcs - Manual CD4-45% Settings 32;':;5;&%;2?:' -

7.4.6.2 Opening a data file

To load a previously saved data file, click on the File menu and choose ‘Open Data file (Settings &
Data)’ or click on the Open icon ( ) on the toolbar.

Each time a saved data file is opened, the instrument settings and page layout are reloaded (except
the sample volume and Flush count). To avoid setting and page layout changes choose the ‘Open
Data Only’ option instead.

7.4.6.3 Loading Data Only

To load only the data from a stored file, without changing the instrument settings and graphs, the
“Load Data Only” option can be used. This menu option overwrites any data currently displayed.
Note that the PMT Voltage settings affect the gain of the photomultiplier optical detectors and so
cannot be changed after data acquisition. Similarly the threshold levels act on the signals from the
photomultiplier tubes so cannot be changed after data acquisition. Clearly the sample delivery rate
and sheath pressures also cannot be changed after data acquisition.

However, many other settings are pure software settings. For example, software gain and datagram
settings can all be changed after data acquisition because they do not involve the electronic

hardware.

The ‘Load Data Only’ option allows you to view any datafile with the current software settings
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7.46.4 Apply Protocol

This menu option overwrites the software settings with those from a stored file, but preserves the data
in the current buffer. The files used are stored in
C:\Program Files (x86)\Apogee\Protocols

and can be overwritten if required.

7.4.6.5 Saving a data file

During sample analysis or after sample analysis has been stopped, it is possible to save the data file

by selecting ‘Save Datafile As’ from the File pull-down menu. Alternatively click the Save icon ( @ )
on the toolbar. Often the AutoSave option accessible via the WorkList header is the best way to save
the data from each sample.

7.466 Adding sample information to the data |—__
file

If you wish to add information to the acquired data, click on
the File menu and select the option ‘Summary Info’ from
the drop-down menu. The Summary information dialog box
appears. These notes are included in the printed report,
and are stored in the data file.

Note that after entering information here, the next sample
run will inherit the same information.

Clicking on the |i‘:.' icon also opens the Summary Info

dialog box. Genenl Acqustion Pasmetens Ssscs

7.4.6.7 Page set-up | "

The page layout for printed reports can be set by clicking the ‘Page Setup’ ; e
option from the File menu, or by clicking the icon.
Upicad custom logeo. Upload

Please make mre the image & around X100
pusis 1 aze

On the General tab you can set the page margins, and header

text. | R , .
o s
; S [Acamien Fowsen | Sseca
On the Acquisition Parameters tab you can choose which Gl
instrument settings to include in printed reports. Sbeacton Ouniy 7
Shesth Presase V¥
You can also set the dilution factor which is used to correct ot
the evts/ul readings to account for dilution during sample Lo

preparation.

For example, if a blood sample has been diluted by a o
factor of 10 during sample preparation you can enter a

Dilution Factor of ‘10’ in order to correct the evts/ul
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5 readings so that the readings of the pure blood are
5 displayed. : = ==
In other words, with a dilution factor of 10, the software will -
B indicate 10 times more events per ul than the machine
actually counts. o 4 Medm P
t:; CV Peak I~ EvertsPerd ¥
Everts v Pecertage M
t‘ Pesk v R 5
Mean 2 CGadSas W
- On the Statistics tab you can choose which statistics to
: display on the printout. By default all the statistics are
selected. e ]
Cancel

7.4.6.8 Print set-up

To open the Print set-up dialog box, click on the File menu and select the Print Set-up option from the
drop-down menu. Standard Windows options are offered.

74.6.9 Print

To print a document click on the File menu and select Print from the drop-down menu.
If there is no need to edit printer settings, simply click on the Print icon on the toolbar.

(=]

7.4.6.10 Current File Excel Export

Sends current data and settings to MS Excel. If no Excel spreadsheet is open, it will create a new
spreadsheet, otherwise it will add the data to the currently open spreadsheet. By clicking this option
once for each datafile a spreadsheet can be created to allow comparison of ROI statistics from
multiple files. Requires MS Excel to be installed.

7.4.6.11 Batch Excel Export

The Excel Export module allows statistics from a batch of data files to be sent to Microsoft Excel ™.
The module works as follows:

o The user clicks the ‘Add’ button to select one or more (use Shift or Ctr keys) data files.

e The user chooses ONE of the data files from which the software will take ROI position
information. This is called the "ROI Data file" and the ROI settings from this file will be used to
analyze all files in the list.

e When the user then selects (highlights) which ROI(s) to display in Excel, the Export button
becomes enabled.
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For example, if using this module to obtain a report showing the number of bacteria in a batch of
samples, each file in the set of data files must have the population of bacteria in the roughly the same

place on the histograms so that the same ROI settings file can be used for all files in the list.

Requires MS Excel to be installed.

Statistics Instrument Settings

¥ cv [7] Threshold Values

[7] CV Peak [V] PMT Voltages

[¥] Events [”] Gain Settings

|| Peak Histogram Channel [¥] Subtraction Seitings

[¥] Mean Histogram Channel [7] Sheath Pressure

[T] Median Histogram Channel [¥] Sample Flow Rate

[¥] Events/d [¥] Acquistion Time

[¥] Percentage of events in ROI [¥] Dition Factor

[ Ratio

[7] Quad Statistics
included Datafiles ROI Datafile: [CD445T0008r1fcs v/
[ X
| Datafile Name || D Name

11

| CD445T0008 r1fcs |1 AutoCD4+

CD445T0008 r2fcs []2 AutoCD4-

CD445T0008 r3fcs []3 AutoCD45+
| CD445T0008 rd fcs (|7 AutoPMN

CD445T0008 r5fcs ’ | 8 AutoPMN

CD445T0008 ré fcs | ‘

Rl PP | ¥ |4 P P—

Data Bxport Progress: | -
Add “Remove | [t o] [ Bpot, ] [ Cose

Flow.com
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7.4.7 The ‘Edit' menu

L %

E‘ﬁ Apogee A40 Elow Cytometer - [SampleData\DefaultA40.fcs
Fie W& View Control Setup Window About

]

¥
'™

g 2 2 )
|9 s
J

'[: @ Cwomrm o8 I | il ][] &l @]9
‘!; Clear Buffer

Refresh CrtH-F4
Auto refresh. ..

batag'am...
Gating,
Scaling

New ROL...
Edit ROL...

| Delete ROI

Copy Datagram to Clipboard
Copy Data to CSY File

7.4.7.1 Clear Datagram

This function clears the data in the active histogram or cytogram, without removing data from the
buffer. ‘Replay’ can be selected to recover the data

7.4.7.2 Clear all Datagrams

This function clears the data in all the open histograms and cytograms, without removing the data
from the buffer. ‘Replay’ can be selected to recover the data.

7.4.7.3 Clear buffer

Clicking on this command all the data will be removed from the histograms and cytograms and from
the PC memory buffer. ‘Replay’ cannot then be selected to recover the data.
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7474 Refresh

Clicking on this command or on the X icon, all the data will be removed from the histograms and
cytograms, and from the memory buffer.

7475 Data Setup Dialog

The auto-refresh option automatically
clears the screen and buffer after
specified intervals. This is particularly
useful when making adjustments to
settings such as PMT voltages and
gains.

Clicking on the Auto Refresh option
opens the List Data Set-up dialog box.

Click on this arrow to select the maximum
buffer size. When the data buffer is full,
the instrument stops collecting data and
the user can choose between clearing the
buffer to continue sample analysis, and
stopping the sample (but keeping the
contents of the current data buffer). A
large buffer requires a lot of PC memory
(RAM).

The simulated data check box can be
used to create simulated data. To see the
real data, deselect this check box.

The RATIO parameter can be plotted on
any histogram as if is a signal from one
PMT. it can be defined here.

&
©
€
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€
€
€
€
€
(=
€&
[ =
©e
©
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&
&=
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&
=

7.476 Datagram

By clicking on this command or on the @ icon, the histogram set-up dialog opens for the currently
selected histogram or cytogram (dual parameter histogram). The same window can be opened by
double clicking the histogram/cytogram or right clicking on the histogram/cytogram and selecting Edit
datagram from the context menu.

Depending upon whether you are configuring a histogram or cytogram, the options are different. For
this reason, the two dialog boxes will be described separately.
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7.4.7.7 Histogram Set-up

7.4.7.7.1 Data Tab

M trovm e T s
Data | Format ] Reference Traces |
Tle: e g e Histogram ;
PARAMETER:  [als  « 2 = 1‘
| Population Detection i
i e PD Region (gG+ : 2 Pulse Heightor @) Peak Peak :
Integral = 1
Re g+ 2 7 Aea Area |
Gate By ‘
ROI: ROI |
b Show Quad Statistics @ AND None T

‘: [F] NOT OR NOT 1
Lok J[ cace J[ oy ]

Title: write a description for the histogram;

Parameter: click on the arrow to select the acquisition parameter;

Peak/Area: choose whether to display pulse height (‘peak’) or pulse integral (‘area’) data;

Channel resolution: click on the arrow to select the channel resolution (between 32 and 65536);
Gating: click on the arrow near to ROI text box on the left to select any region of interest to be used to
gate the data. If more than 1 region of interest is to be used for gating, choose a Boolean operator.
Tick the box to gate by events NOT in the selected region.
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7.4.7.7.2 Format tab

Qki:bgmnm

Appearance / Display
Resobson ;004 - Scaling Linear / Log
Scale Ado > x Linear -

Draw Mode Y =

@ Line 7 Show Threshold Valuss =
Sat: 40 - End: 1023 =-
|
3 |
4 1
| [Lox ][ Cace Aol

Draw mode: Choose between line and filled modes;

Threshold: click on the check box to display the threshold value on the histogram;

Scale: Select the vertical scaling (number of events per histogram bin); if Auto is selected, the
histogram y axis will scale automatically to the histogram channel with the most events inside the

Auto Scale range specified.

Auto Scale channels: insert into the text boxes the starting and ending point for the Autoscale.

X: click on the arrow to select the x axis mode. Linear or logarithmic options are available. When
plotting a logarithmic scale, you can choose to hide the first one or two decades. So the log scale can
be plotted with 4.8 (“Log — full"), 3.8 (*Log — 1st”) or 2.8 ("Log — 2nd") decades
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7.4.7.7.3 References Tab

8y} Mistogram Setup

|
|

;
§
i

(Do ] Feferrce Taces |

Active
Ref A
Ref B

Ref C:

1 RefD

Ref E

RefA
RefB

B

E
—H

&

RefD
RefE

(Right click on Histogram to add or remove reference traces)

T == N ™

[e]

This self-explanatory menu can be used to configure the draw mode for reference traces saved by
right clicking on a histogram.

Histogram data from multiple files can be overlaid by the following steps:

With data for the first histogram trace displayed, right click on a histogram and save
the current data trace as a reference.

Load the second data set that you want to compare using the ‘Load Data Only’ option
on the file menu.

The previous reference trace and all graphs will be maintained, but the new data will
be played.

You can now save this second data set as another reference trace.

Repeat to overlay up to 5 datasets

Saving the file will also save the reference traces
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7.4.7.8 Cytogram set-up

7.4.7.8.1 Data Tab

Title: You may enter a description for the cytogram.
Parameter: choose the two acquisition parameters;
Peak/Area: choose whether to display pulse height (‘peak’) or pulse integral (‘area’) data;

=
IP Cytogram Setup i R @
Data | Format
]
Title: S = g e o Histogram “
X Y ,
PARAMETER:  [gals LALS ~ ‘
Population Detection [ J ﬁ J [
atato PD Region §gG+) g +] Pulse Height or @) Peak @ Peak

e ——— Integral 3, = [
DRegon oG [p = ] © Area © Area ‘

i T Gate By
ROL: Rgl: Tone !
7] Show Quad Statistics OND [ewe = ;
[F NOT OR [ noT (

Lok ) [Concel ][ seot |

Gating: click on the arrow near to ROI text box on the left to select any region of interest to be used to
gate the data. If more than 1 region of interest is to be used, choose a Boolean operator.
Show Quad Statistics: select this check box to draw quadrants on the cytogram.
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7.4.7.8.2 Format Tab

P

P
@

L

u Cytogram Sewp
Data_| Fomat |
Appearance / Display

Resoltion (512512 Sealing Linear / Log

Draw Mode

@ Line [7] Show Threshold Values

© Dot Plot Auto Scale Range: e
) Color Plot Start: 5 = End: 511 -

wp
@

J

yaninizg
g
E
i
Jl

s R

Channel resolution: click on the arrow to select the channel resolution (between 32 and 1024);
Draw mode: click on the selection box to choose between line, dot plot and colour dot;

Threshold: click on the check box to see the threshold value on the histogram;

Scale: click on the arrow to select the end of scale of the z axis (frequency); if Auto is selected, the
cytogram z axis will update automatically to contain all the events. Within the Auto Scale Range.
Auto Scale channels: insert into the text boxes the starting and ending point for the Autoscale.

X and Y: click on the arrows to select the x axis mode (linear or logarithmic with 4.8, 3.8 or 2.8

decades);
7.4.7.9 Gating

Click the icon or select ‘Gating’ from the ‘Edit’ menu to view the Histogram Setup menu on
which you can specify gating rules for the current histogram, e.g. ‘only show particles which fall inside
region of interest number 3'.

7.4.7.10 Scaling

Adjust the scaling of the current histogram or cytogram by opening the Histogram set-up or the
Cytogram set-up dialog box (see above). Alternatively use the controls at the top left of the datagram

window.
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7.4.7.11 ROI Dialog

The ROI dialog offers various statistical and format options.

It can be accessed by clicking one of the toolbar icons:
(] [ie] [ig]

On the General tab it is possible to set the name and
the colour of the ROL. In case of cytogram it is also
possible to select the type of ROI to be drawn:
polygonal, elliptical or freehand.

The statistics are written using the chosen ROI colour,
so avoid the use of very light colours that may be
difficult to read on printed reports.

On the Stats tab it is possible to select the statistics
shown at the bottom of the datagram. In case of
histogram there are more possibilities:

e CV = coefficient of variation (100x
standard deviation divided by the
mean);

o CV Peak= coefficient of variation
calculated at half height of the peak;

e Events= number of events inside the
ROI;

e Peak= modal channel of the
population in the ROI;

e Mean= arithmetic or geometric mean
histogram bin of the population;

e Median= median histogram bin of the
population in the ROI,;

e Events/pl= number of events
(particles) in the ROI per microliter of
sample;

e Percentage= percentage of the events
inside the ROl compared with the total
number of events.

For cytograms the options are limited to Events,
Events/pl and Percentage.

The Ratio tab gives to the user the possibility to set an
arithmetic calculation between two different ROI.

To do that, click on the Ratio check box to activate,
click on the arrow close to the ROI1 text box to select
the first region of interest, select the mathematical
operator to be used by clicking on the opposite check
box and finally click on the arrow close to the ROI2 text
box to select the second region of interest.
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74713 Delete ROl

This command delieies the curmeniy sliediad RO (ssfiect and RO by didiang on ). The cursrily
sslieci=d RO has is d=i= dispisyed af T bofom of e hisiograrm window.

7.4 714 Copy datagram to Clipboard

This comrmand copies e ssiecied deiagrarm e Windows Clipboard, © be used wiss ofer
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2 graphuc program: (e Windows Painl),
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748 The ‘View' Menu

This menu allows sections of the screen to be hidden. In this way it is possible to customize the
screen view.

m . - :
im Apogee A40 Flow Cytometer - [SampleData\DefaultA40.fcs]

D)\ vt el |w || o] Ll |eflin] c-lio] Sl B2
:;::Ba —_—— e
pr——
Log Gain

7.4.8.1 Control Panel

Toggles the visibility of the Control Panel on the right part of the screen. If not selected, the
histograms and cytograms will fill the work area of the screen. Alternatively it is possible to

click on the toolbar icon :

7.4.82 Toolbar

Toggles the visibility of the toolbar on the upper part of the screen.

7.4.8.3 Status bar

This toggles the visibility of the status bar on the lower part of the screen.

7.4.8.4 Scale boxes

Allows to hide or show the scale boxes on all the histograms and cytograms on the screen.

7.4.8.5 Log Gain

Activates the log gain check boxes on the Control Panel Gain tab.
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7.49 The ‘Control’ Menu

This menu contains commands, most of which are also present on the Control Panel.

%ﬁ Apogee A40 Flow Cylometer - [SampleData\DefaultA40.fcs]

e BR Voo N S Wibw A0 L T T e T
D@ P |s|a@] o ]X] L@ 2]e]z] £e B2
B Run F10 e e e Ty B e S
| Stor F
e SRR
' Stihtractin...
Gain
7.4.9.1 Replay

Alternative click on the m icon on the toolbar. This button replays data in the current data
buffer. After changing gating of gain settings, replay the data for the new settings to take effect.

7.49.2 Run

Runs a sample. Normally this is not required because samples automatically run when the

sample arm is moved into the run position. Alternatively click on the E] icon.

7.4.9.3 Stop

Stops a currently running sample. Alternatively click on the IE‘ icon.

7.4.9.4 Flush

Flushes the sample tubes. Make sure the sample arm is in the flush position first. This button is
not normally required because the machine automatically flushes when the sample arm is

moved to the flush position. Alternatively click the @ icon.

7.4.9.5 Subtraction

For compensating for spectral overlap when multiple fluorescent markers are used. This
command takes you to the Subtraction window; also accessible via the PMT tab on the
Control Panel.

See section 7.3.5.2 for further information.
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7496 Gain

This command takes you to the Gain tab of the Control Panel. Software gain is applied to data as it is
collected, but you can choose to save the data without the gain settings (see checkbox on Control
Panel). These gain settings can also be used to apply post analysis gain to data, but first select
"Apply settings on replay" from the settings menu or check the box on the Gain tab of the Control

Panel.

7.4.10 The ‘Setup’ Menu

This menu contains several commands
which do not appear in other windows.

7.4.10.1 Time per channel

Adjusts the time interval per histogram channel. This
applies to histograms with time selected as one of the
axes. Time can be selected from the Histogram set-
up menu which can be accessed by double clicking
the histogram. For example, this is useful if you would
like to plot a graph of cell fluorescence versus time.
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EB Apogee A40 Flow Cytometer - [SampleData\DefaultA40.fcs]
Fle Edit View Control =N Window About 3

= 7‘; :  Time Per m‘
I 51 [Peak]- SALS Data Setup...
3 Auto Save...
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v Apply Settings on Replay
Apply Settings to Data Buffer
| save Data with Gain & Subtraction

Count A110

Check Firmware Version

Population Detection
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7.4.10.2 Autocycle

E B

2

¢ Vv U e v

i- For automatically stopping samples after specified
- y stopping ples a p
l 3 numbers of events or after a specified time interval. p,@ - -

— Click on the arrows near to the text boxes to select 3 0 =
- I MnT ¥ Max Time -
i]D the minimum or maximum number of seconds of % oy = 7
- acqqisition or, if preferred, the minimum e = [Nore =] [ MirROIComnt =]

maximum number of events to be acquired inside a P
!,w specified ROI. Nome  v| [ MaROICom | =
{3 Select post acquisition operations to automate the i sesbi
job.
j To activate the Autocycle, make sure the ‘Autocycle W Auto Clear Datagrams I™ Auto Pt Report
. On’ checkbox is checked. - : —
E _ Cwd |
7.4.10.3 Data Setup
The data buffer size allocates computer memory for P

temporarily storing the data. If the buffer size is large |
and the PC has less than 512MB RAM, the PC will | Replay (O Sow [ SemistedData

run slowly. ; @ Fest
|
Auto-refresh options are also available | nantwss EaGERESE
from this menu. Auto Refresh ‘
automatically clears the screen and ‘ Ao Refreah
buffer after specified intervals. This is [ AterEvents. & 2
particularly useful to service engineers ‘ -~
= 3 i | [ Aer Time i F
when aligning the machine. :
When the data buffer is full, the instrument RATIO Parameter
stops collecting data and the user can choose between clearing the L e [T ® Peak
buffer to continue sample analysis, and stopping the sample (but p
keeping the contents of the current data buffer). o
Denominator: 4058 8) PFeak
The simulated data check box can be used to create simulated data. oy
To see data from the FCM Control program deselect this check box. et facker: |20
EE‘K Cancal
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7.4.10.4 Auto Save

nAAANNN S |

Auto Save
If running a batch of many samples, it is ¥ Enable Auto Save
convenient for the data to be saved automatically.
SamplelDs entered in the WorkList are used for Folder Path [C\Documents and Settings\All Users'\Docume
the file name, or an automatically incrementing file
name is issued. ok | concel |

When this option is enabled, the data and settings are saved automatically in FCS3 format when a sample
stops. If the sam.ple was Queued in the WorkList then the SamplelD will be used as the file name and the
Sample Notes will be set to the ‘Description’ in the WorkList:

] Gt P ——— e

T I Ve Gt Gy Wedo et

SO WSO NUNEY UBEEE CEF R KO E BT

Ll:-mwt-p—l-; OX |2 40805453 Gre Pusk Pom| OX | 7o Pestt
s . Im -

O X W Comst Prnsi

19911 3 %
- H H _

With these WorkList settings, when instructed to Run, the machine will take a sample from well A1 (96 well
plate) and save the data when the sample stops with the file name “Buffer Control.fcs” in folder “C:\Temp”.
After 1000 files have been collected in the specified folder, the e e
oldest file is deleted when a new file is saved to avoid filling up the

ROl usetc  1-Everes

hard disk. Specify a different folder before this limit is reached to 1 2 3 45867 898 101 @
avoid losing the old data. Q00000
B
A ‘View Plate’ button is in the WorkList header for software c@00
versions after 255.0.0.158. This offers the following features: D
E
o Click on a well to add it to the WorkList. .
o Double click a well to add it a second time to the WorkList g
if you want it to be run twice. -
e Add an ROI statistic to the WorkList and then select the
statistic in the Plate View to colour the wells according to sl 28 Qe 3 B W
the value of the statistic. B Aeen =
£ swome e T
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7.4.10.5 Set Default Folder

Allows the user to change the default file load and save folders for fast and convenient file management.

o U v v

] ;
7.4.10.6 Apply Settings on Replay

>

When this is selected, gain settings and subtraction settings are applied to the current dqta buffer when

D 'Replay' is selected. The data file is not modified and if saved after applying different settings, no changes

will have been made to the data.

7.4.10.7 Apply Settings to Loaded Data (Apply Settings to Data Buffer)

To enable this option, ‘Apply Settings on Replay’ must be checked/active. Select this menu option to apply
the current gain and subtraction settings to the current data buffer. The current data buffer will be
permanently modified and the subtraction and gain settings will be reset to their default values (0 for the
subtraction controls and 1 for the gain controls). Use this option with caution because there will be no
record that you have modified the data in this way. It is more common to store the data without gain and
subtraction, and to apply the gain and subtraction settings on replay rather than permanently applying the
settings to the data with this menu option.

7.4.10.8 Save Data with Gain and Subtraction

The ‘Save Data with Gain and Subtraction’ option determines whether, when the current data buffer is
saved to a file, data is saved before or after gain and subtraction settings have been applied.

Users may choose between the following typically modes of operation:

1 Select ‘Apply Settings on Replay’ and deselect ‘Apply Settings to Stored Data’.

When the data buffer is saved to a file, the data is stored in the file before any Gain or Subtraction has
been applied. Gain and Subtraction can still be used while running samples, and Gain and Subtraction will
be applied upon replay, but the machine will store the raw data when you choose ‘Save’. This makes it
simple to change Gain and Subtraction settings after running samples.

OR

2 Select ‘Apply Settings to Stored Data’ and deselect ‘Apply Settings on Replay’.

When the data buffer is stored to a file, the data is stored after Gain and Subtraction have been applied. In
this case you must deselect ‘Apply Settings on Replay’ to ensure the gain and subtraction settings do not
get applied a second time when the data is replayed or loaded from the saved file.

7.4.10.9 Check Firmware Version

This option is not normally used. It causes the histogram software to check the FCM Control version next
time the histogram software starts. If communication with the machine fails, it may be necessary to click
this option to recover full operation. Each time you run the histogram software, when the histogram
software connects to the FCM Control program, a splash dialog is displayed giving the FCM Control
(‘firmware’) version detected. The current FCM Control version is also displayed on the top line of the

MiniFCM'’s display.
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Make sure the ﬁrrqware FCM Control version detected upon connection, agrees with the version displayed
on the MiniFCM display, if not, select this menu option and restart the histogram software

7.4.11 The ‘Window’ Menu

These options are self explanatory. The window management system allows easy changes between tiled
and tabbed display modes via toolbar icons.

Wm N E -
misy Apopee A40 Flow Cylometer
File Edit View Control Setup B

e el e o Pl clofo] Sl @le]]

= =L 2T 122 New Cytogram rhe e

Close all
’ v Auto Arrange

j 1 FCM Contral
| v 2151 [Peak] - Light Scatter
3FL1 [Peak] - Fluorescence

|
} Arrange All 3
| |
| |

7.4.11.1 New Histogram

Opens a new histogram on the working space.

7.4.11.2 New Cytogram

Opens a new cytogram on the working space.

7.4.11.3 Arrange All

Arranges all the opened datagrams in the work space. Alternatively click the

icon.

7.4.11.4 Close All

Close all the opened datagrams in the work space.

7.4.11.5 Auto Arrange

If checked, the histogram and cytogram windows get arranged automatically.

www.ApogeeFlow com Page 66 of 90 Doci#16004
20 April 2020

LA ARARANAANARAEDNANRNANAARAAANRANNNAR



"

THIS DOCUMENT MAY NOT BE DISTRIBUTED OR COPIED
/ WITHOUT EXPLICIT PERMISSION FROM APOGEE

' APOGEE

FLOW SYSTEMS

W- TR @
\ ™ :

o e o
g U 9 9

7.4.12 The ‘About’ Menu

| |

o

Shows the installed software version and copyright information.

v ¥

7.4.13 Histogram & Cytogram Context Menu (right click)

=
o

L LS2 [Peak] - LALS

v ||Gated by 1 beads

tindink |

Count AI500
&
=
=
&
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=
|
23}
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- |
3
1
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o
o
3
I
A
T
w
@
El
2
73

6 480nm

As Reference » W_éo;%_dem_l-mmf;r

emerereens -

5 440nm CV=2 7 E vents=35888 Peak=1408 Mean=1426 Evt/ul=8606 ROI%=40.3%

The context menu is available by right clicking on a histogram or cytogram. It offers functions available on
other menus plus an option to save and delete reference traces. The draw mode and description of the
reference traces can be edited using the histogram setup menu. The reference trace feature is available
for histograms only. The number of references is limited to two for very high resolution histograms.
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7.5  The ‘FCM Control' Software

the hardware. It runs on the computerlinside
hen Windows starts and requires no
he FCM Control program may not be

The FCM Control software controls and receives data from
the cytometer. This program runs automatically in the background w
user interaction. When logged in without administrator permissions, t
visible in the Task Manager.

Apogee Flow Cytometer (v3.36)4' % Diagnostics [PIPE -

Pleage wait
_s.gmu_.:mnm_n___r___ rHY coMz =
r Hv2 COM 4 &
COl

rop M1

Display

I~ Enable LCO

© PCi Card © PCPort i
Lest operation: Initialize 0378 f

LEEEE e

Agistor [0 Amosy [0

|
B
awsx [0 awsz [0
i
!

W Auto-Run Histogram Softwere

olefo|o]e] T

I8 Apogee PC Control (3.50) - FCM Stopped = X

5 RS232 Port Assignment
¥ Temina
[~ Pudics |COM2 v
[~ HY COM3  ~w
Chve  [ooMa ]
[ Laserl |COM10 v|
[ lasez [COMUI ¥
[ Laser3 [COM12 |

[ Laserd [COM1S +|

- Auto-Run . 5
HistSoft |7 220t dat
Hawk USB Coms

Agtator | 0 AutoS'Y ;6
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7.6 Work List Functionality (Histogram application)

The Work List option facilitates sample management and also data analysis. It is required for systems fitted
with an AutoSampler but can also be used when running samples manually as it is a means by which to
enter information about a group of samples you plan to analyse and offers a means to compare data from
multiple samples.

You can enter a list of samples (or open a worklist created in csv format) and then run them one by one:

SErNEF I EEEE EEE O EEES®R
o OX | LASPek] DX |_FLiPeai |
-] ] ] |
g 2 2 ‘
< 1 < <
e — B )
£ =
SALS LALS FL1 Thresholds & Lasers | Notas
s - 1024 1024 1028 Ty Resds
1CV=00 Events=d Means0 [ Corts Con | PMT.
p--— = | Control | Service | Gain | PMT
L F2Pey OX |_FL3[Peak] 0 x [CFi4{Pea g% soen [on [T
o) o] o) | Ao 1 2
S o] o] | hficy u '
S o |
< < Z | SAMPLE 273
» ] | e [
S
S i 3 | SHEATH (28 wbar
F2 FL3 L3 DATA
r 1024 y 1024 - 1024 | Taal Siac
! evits/| I al
B4 Worklist 2 o | |
S 0 T RS evis/s |
Ghoose Rack type |95 Wel Piate «| Folder Name:  C \Users\OJK\Desktop 2 Ei [ - 0
Wk Pleicon¥) £ rate 0%

Sample D
1245
67851
246
78501 |
#3012 ' i B | ' I

AutoRetresh Daabied
—_——

Work List

Samples must be given an ID, a location and must be Queued in order for them to be processed by the Autosampler. The Work
List can also be used to compile a comparison of previously saved datafiles by adding columns for ROI statistics and then loading
each datafile in turn.

The Work List can also be used to compare data from multiple samples. This is done by:

1) Creating appropriate ROls

2) Using the 'Add ROI Statistic' button to add columns to the WorkList to display the statistics of interest
3) Using the 'Load Data Only' option on the File Menu to get data from a previously run sample

4) Clicking the Work List button 'Add Datafile to WorkList' to add the current file's information to the Work
List.

An example is shown below.
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Refer to the AutoSampler Chapter for more information.

Histogram application version 255.0.0.205 and later offers the ability to specify a settings template to use
for each sample. The template options are the files stored in the folder C:\Program Files

(x86)\Apogee\Protocols
3
* T T - ree
iy — PP— . v
Fle Open Mode  Datas Orey v Gy Obeer Keryon'\Deshicp\AsoSave Atcsove Pah ® © @ ° B El X H
) Pate Snabe ] Sk 6 St Vi Plste ] As Snadoun

AutoRetrests Daabled
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7.7 Axes Calibration (Optional)

The optional calibration module allow a calibrated scale to be displayed on any axis. The scale must be
configured in the factory or during an instrument service visit. Calibration scales may be plotted along an
axis (for fluorescence) or in two dimensions on a light scatter cytogram as shown below. Available scales
may be selected for display or hidden via the Datagram Context menu (right clicking on the datagram).

The below graph shows the display of calibrated scales on a two dimensional light scatter ‘cytogram’.
These curves are for n=1.42 and n=1.38, but other curves can be added and a gate or ROI defined
according to the size and refractive index of interest.

™
SNFEOE NI rR ML EFIBERFE O DEE Y
o -

Apogee's flow cytometers can be calibrated to give size information from the light scatter data for particles
of approximately known refractive index. Bacteria and similar particles generally have a refractive index of
around 1.38 but conventional flow cytometers are calibrated using only latex beads with a refractive index
of 1.59. Due to this large refractive index difference, latex beads can give misleading results if used to infer
biological particle size by their light scatter signals.

Apogee's Light Scatter Calibration Module (Cat# 1492) offers a scale, calibrated for a particular refractive
index, on the light scatter histograms. The instrument is set up during an instrument service visit or in the
factory. Calibration can be done at almost any refractive index greater than the refractive index of water,
and multiple scales can be displayed on any light scatter cytogram to allow the operator to capture
particles within a particular size and refractive index range.

The calibration scales can also be used to display fluorescence calibration data so that the number of
Molecules of Equivalent Soluble Fluorochrome (MESF) can be determined.

For further information refer to Apogee document #16023 for product #1492
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Templates for the test bead samples and also for common biological samples may be stored in

so they appear on the File-—Load Settings pull-down menu (see image below).
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8. Routine Operation

Itis generally recommended to verify the cytometer’'s performance with reference particies (test
beads) at the beginning of each session of use. The demands of the application will determine how
thoroughly it is necessary to check the instrument’s condition. For example, use in 2 GMP
environment may require a thorough daily control inciuding analysis of the following samples al the
beginning and end of each session of use:

e Running a mixture of test beads (e.g. ApogeeMix, Cat£1493) to verify the machine has the normal
light scatter performance and the normal fluorescence performance on green and orange
detectors on blue and violet lasers.

e Running other test beads to verify the cytometer has the normal fluorescence performance on any
other fluorescence detectors (e.g. Cat# 1478 for detectors on the red laser, Cat= 1444 1o take red

fluorescence measurements from fluorescence detectors on the blue and violet lasers.

* Running a sample of purified water with a low light scatter trigger threshold to verify the fluid
systems are clean. For example, for Micro models set a light scatter trigger threshold to the level
where 110nm polystyrene beads appear; for Universal models set the light scatter threshold to
where 200nm polystyrene test beads appear. A clean cytometer should then give fewer than 200

events per second when running a sample of purified water at 3ul/min.

* Running beads of carefully controlled concentration (e.g. Apogee Cat#1444) multiple times to

verify the counting precision and accuracy.

C:\Program Files (x86)\Apogee\Protocols

I -

Tau

ﬂ‘,-

-Apogee Histogram Software - [C\Program Files (x86]\Apogee\Protocois\Default fcs]

de | Edt  View cmmwmw

Open (Settings & Data) (w0
Load Data Only

Apply Protocol...

Save Datafile As Cide S
Clese

Summary Info

Page Setup and Dilution Factor

Prnt Setup

Pant CurteP
Current File Excel Expont

Batch Excel Expornt CurieE

Load New Shesth

Ext

Recent Files

<

Bactena Viabdity Temalnt.lv:s

o ‘llull Eaw

| B Templatetes
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Virus Template fcs

www ApogeeFlow com
20 Apni 2020

Page 72 of 90

Lo a0nn i

Q222 RRRRRARD



v

:

[

¥V U o v

v

T R T T RN T RN T N SN TSN 7 WY
@ U 0 Vo Yy

n
U

2
P
-

A

8.1

APOGEE

FLOW SYSTEMS

Operation with the “Histogram” application

8.1.1 Instruments without ApoCAL calibration option (non-GxP models)

8.1.1.1 Start-up & QC

1)

2)
3)

4)
5)

6)

7)
8)

9)

10)

If using a separate PC for the histogram software, turn it on now. Windows must have started on the
external PC before you turn on the cytometer in order for the cytometer to know the external PC is
connected. See section 6.3, Network Configuration for how to set up the LAN connection.
If the cytometer has the manual sample arm (no Autosampler) check the sample arm is in the flush
position.
Fill the sheath fluid tank with deionized water containing 200yl of Sheath Fluid Preservative (Apogee
Cat#1516) per full tank of water. Empty the waste tank. Top up the cleaning fluid tank if necessary.
Turn on the cytometer using the push button on the front panel.
Windows is normally set to automatically run the FCM Control program. Once the machine is
Initializing (not before), the FCM Control program is normally set to automatically run the histogram
software. The firmware version should be momentarily displayed, indicating a connection has been
established between the histogram software and the cytometer. If the connection fails make sure
only one copy of the Histogram software is running (check Windows Task Manager for instances
which may have failed to close properly) and refer to sections 6.3 and 7.1.
After the Initialize cleaning cycles are complete, the instrument status bar in the histogram software
will say “STATUS: Idle Clean”.
Load your reference test bead settings file.
Run a sample of your reference test beads and check that the data is sufficiently similar to your
standards. For example verify the CVs and signal strengths are within acceptable limits.
Daily or weekly, depending on how critical the counting accuracy is in your application, check the
counting accuracy as follows:

i) Run some Apogee calibration beads at about 1.5ul/min for approximately 200 seconds and

record the concentration of particles (evt/ul) in the singlet peak.
ii) Run the same beads again at 10ul/min for 100 seconds.
iii) Verify that the measured particle concentrations agree with one another to within 15% and
agree with the value on the bottle to within 15%.

Run a sample of purified water or buffer to check the fluidic cleanliness. For Micro models, set a
trigger threshold at the position of the 110nm polystyrene test beads on the MALS or LALS detector
and make sure there are fewer than 250 events per second. The event rate typically falls during the
first 20 minutes of operation.

Note that when the histogram software is run, the file:

C:/Program Files(x86)/Apogee/Protocols/Default.fcs

is automatically loaded. This file contains stored data and does not indicate the current state of the
machine. This file can be modified to your reference calibration settings.

During installation of the machine, suitable settings files and reference data should be discussed
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8.1.1.2 Running a Sample
If the controls in the previous section are successful, the instrument is ready to analyze biological samples.

1. Click the [E' icon on the toolbar; In the Open dialog box, locate the desired data ﬁle and click on
the Open button. Alternatively load settings from the File---Load Settings menu option.

2. Make sure a file AutoSave path has been entered in the WorkList header and enter a sample ID
for the sample you are about to run into the work list.

3. To run the sample which should have a tick in the Queued column of the Work List, move the
sample arm to the Run position or simply click the Run button on Autosampler models.

4. When the instrument starts collecting data, move the sample arm to the flush position (manual
sample models) so the machine can flush automatically when the acquisition stops.

5. After each sample, the datafile will be automatically saved with the SamplelD as file name.

Sample load/run position Intermediary position when moving ‘Flush’ position
between ‘run’ and ‘flush’

If an Autosampler is installed then a 'Manual Sample' can be run simply by entering the SamplelD in the
Work List, inserting a tube in the transparent acrylic tube holder and clicking the 'Run’ button on the Control
Panel. See section 9 for further details.

8.1.2 Instruments with ApoCAL calibration option enabled (GxP option)

8.1.2.1 Start up & Auto-Calibration

The software may be configured to operate in ‘GxP’ mode (refer to section 7.1.3), suitable for use in
regulated environments where data integrity and ease of use are high priorities. The system automatically
calibrates to ApoCAL test beads (Cat#1524) and user permissions are limited to minimize the chance of
false results.

The ApoCAL software (included in Cat# 8057) algorithm operates in the FCM Control program. The
Histogram application does not participate in the calibration algorithm other than to display instrument
status information, to turn Calibration mode on and off and to set instrument settings suitable for the
calibration which it obtains from the file C:\Program Files (x86)\Apogee PC Control\ApoCAL fcs

During the self-calibration, the FCM Control program adjusts the PMT voltages and checks the counting
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accuracy. File C:\Program Files (x86)\Protocols\'ApoCAL.fcs contains suitable settirygs for the ApoCAL test
bead mixture (Cat#1524). This protocol/template will be loaded each time the machine performs a
calibration.

To instruct the machine to perform a calibration, queue a sample (in the WorkList) with Sample ID
beginning with the characters “ApoCAL" or click the Calibrate button (level 3 users only) on the Control
Panel of the Histogram application.

The following steps should be followed to turn on and calibrate the machine each session:
1) Fill the sheath tank. Check the Cleaning fluid tank is at least one third full. Empty the waste tank.
2) Switch on the machine. The machine may start to clean itself before a user has logged in.
3) Log in to Windows.

4) After one or two minutes Windows will automatically run the Histogram application and a default
file will load.

5) While waiting for the machine to finish its “Initialize” cleaning routine (approx. 5 mins), click the
AutoSave path button in the WorkList header and set a new folder for this session’s data.

6) Insert a microcentrifuge tube containing approx. 0.5ml of ApoCAL beads (#1524).

7) Wait for the initialize routine to finish and check the machine’s status is “Ready for a Sample”.
The instrument status bar in the histogram software should say “UNCALIBRATED: Idle Clean”.

8) Enter the SamplelD “ApoCAL” in the WorkList then press F10 or click the Run button. For
manual sampling machines move the sample arm to the Run position.

Allow the machine to analyze the sample. To position the test beads in the correct position it may
automatically adjust the PMT voltages on up to three occasions, each time clearing the data buffer. Allow
the machine to analyse the sample for at least 90 seconds.

The instrument calibrates itself by positioning the calibration bead populations on the histograms and by
checking the number of particles per volume of sample. If the concentration of the measured calibration
beads is outside the normal, or if the brightness of the measured calibration beads differs from the
expected brightness by more than is normal, the machine will tell you “Calibration Failed".

The calibration status is displayed on the Control Panel and in the status bar. Do not operate the machine
unless it is in the Calibrated state. A log file of calibration results is maintained in:
C:\Users\Public\Documents\Apogee

8.1.2.2 Dilution Factor

A 'Dilution Factor' may be set in the histogram software so that the machine calculates the correct particle
concentration from samples which have been diluted. For example, white blood cells are often analysed in
whole lysed blood at 20ul/min after dilution by a factor of 10; blood plasma is often diluted by 100x before
analyzing its content of extracellular vesicles at 3ul/min.

If you run undiluted test beads with a dilution factor set, the histogram software reports a ‘corrected’
concentration to allow for the dilution. So, for example, on the bottle it may say that the beads are 1,000
events per microlitre, but if a 10x dilution factor is set, the histogram software will report 10,000 per
microlitre. The dilution factor setting has no effect on the FCM Control program in which the calibration is
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performed, so dilution of the ApoCAL test beads will cause the calibration to fail regardless of the dilution
factor.

8.1.2.3 Running Samples

After a successful calibration, the instrument is ready to analyze your samples. The calibration state is also
displayed on the status bar and Control Panel in the Histogram application.

An AutoCycle should have been set in the protocolitemplate files for the ApoCAL samples and for the
biological samples. These settings automatically stop the sample after a set period of time and/or when a
certain number of particles have been detected.

The AutoSave option in the WorkList header should be set and then SamplelDs entered in the WorkList for
the set of samples you intend to run. The data will then be automatically saved with the SamplelD as the
file name when each sample stops.

8.2  Shut-down procedure

To clean and disinfect the system after running biological samples it is recommended to shut down the
machine as follows:

1. Run a 200ul sample of 1% sodium hypochlorite (10% bleach) solution at 50ul/min until the sample
runs out.

2. Set a relatively low light scatter trigger threshold. The trigger level should be chosen to exclude
optical noise but low enough to allow triggering on particles in the sample and sheath system. For
Micro and Micro-PLUS models you may set the light scatter trigger threshold to the level of 110nm
polystyrene beads. For Universal models you may set the light scatter trigger level approximately 1
decade below the level of 500nm polystyrene test beads.

3. Run a sample of filtered water at about 5pl/min and judge the cleanliness of the system by the
event rate. A clean instrument should give less than 250 events per second (trigger level
dependent).

4. Repeat the water sample until the event rate is sufficiently low to indicate the machine is clean.
Failure to ensure the machine is clean in this way risks damage to the flow cell due to deposits of
proteins on the optical surfaces of the flow cell crystal.

5. Click the “Shutdown” button on the Histogram Software Control Panel and allow the machine to
perform its cleaning cycles and turn off.

Never switch off the instrument without performing the shutdown procedure
because the fluidics may be left in an unclean state
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9. AutoSampler Operation

The optional AutoSampler is a convenient system to
process large numbers of samples. It requires racks which
conform to the industrial standard 96 well plate format.

Control of the AutoSampler is normally via the Work List
panel in the Histogram Software, but 'Manual' samples
may be run by placing a sample tube in the Manual
sample position (see photo). A sensor detects the
presence of a sample in the manual sample position and

the manual sample will be given preference over the rack
of samples.

In between each sample, the sample aspiration probe
automatically moves into the Flush Cup for cleaning.

If no sample is present in the Manual
sample position, the computer will Flush cup
process Queued samples defined in (for probe

the Work List and save each datafile cleaning) /

in the assigned folder. Each sample
must be given an ID, and must have
its 'Queued' checkbox ticked.

ROI statistic columns can be added to Manual
the Work List table to facilitate sample
comparisons between samples. position

Histogram Software version 255.0.0.205 and later offers the ability to specify a settings template to use for
each sample. The template options are the files stored in the folder C:\Program Files

(x86)\Apogee\Protocols

—

www.ApogeeFlow com Page 77 of 80
20 April 2020




/A aposee

9.1 AutoSampler Probe Height Adjustment

The probe height must be considered when deciding on the volume of
sample to use in the microcentrifuge tube or plate well. If the probe does
not reach the bottom of the container then, of course, more sample is
required in the tube to avoid aspiration of air. The probe height may be
adjusted by loosening the nylon clamp screw.

Nylon
probe
clamp _~
screw

9.2  AutoSampler Fault Diagnosis

When the instrument first turns on, during the Initialize procedure, a test of the mechanism is performed to
make sure it is free to move throughout its full range. Apogee's Terminal program can be used by
Advanced users to check whether this 'Self Test' passes or fails.

The stepper motors which drive the mechanism in the horizontal plane, have limited power to minimize the
risk of damage in the event of a failure or obstruction. The shafts require periodic cleaning and lubrication
with grease to ensure there is no significant resistance to movement.

The AutoSampler electronics is interfaced with the PC via USB connections. If these communications have
failed, or if the 'Z' sensor has been interrupted, it may be necessary to restart the instrument. After a re-
start, if there is still no movement of the AutoSampler during the Initialize procedure, and if all the sensors
have been checked, it is possible that the driver for the USB communications has become failed. In
extreme cases it may be necessary to unplug the USB cables for the AutoSampler, restart the PC, then
plug in the USB cables again. Consult Apogee before doing this as the cables should be connected in the
correct order (although the order can be changed in the FCM Control program).

The AutoSampler is fitted with the following sensors:

SENSOR DESCRIPTION NOTES
Cover sensor Micro switch to detect a Mechanism will not move unless the cover is closed.
closed cover Software will wait for approx 15 seconds for the

operator to close the cover and LEDs may flash to
indicate this error state. After this period the user will
need to click 'Run’ or 'Flush' in the software after
closing the cover.

Manual Sample Sensor A small sensor to detect the Manual samples have priority over samples queued
presence of a tube in the in the rack of samples
'Manual Sample' position
X motion sensor Detects when the mechanism | Self test at startup verifies that the mechanism is
reaches the end of travel in free to move the full distance (use of Terminal
the X direction (longest program is required to verify)
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movement)

Y motion Sensor

Detects when the mechanism
reaches the end of travel in
the Y direction (shortest
movement)

Self test at startup verifies that the mechanism is
free to move the full distance (use of Terminal
program is required to verify)

Z motion sensor

Detects when the sample
probe is prevented from
lowering into a sample or into
the flush cup.

This error is treated seriously and the instrument will
need to be restarted to recover from this state. Until
a restart, the Autosampler will not function.

The 'Z' sensor
detects a gap
between these two
blocks. This fault
condition can
happen when the
aspiration tube(s) hit
an obstruction during
the downward
movement (for
example due to a
misaligned rack of
samples). The
sensor is located on
a small PCB fi9xed
to the sliding block
on later models.
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10. Troubleshooting: Common questions

The data looks abnormal but the instrument settings are thought to be correct.

The histogram software doesn’t communicate (cannot connect) with the FCM Control ;oftware.

The sample does not automatically run when the sample arm is moved to the run position.

The flush doesn't start automatically.

The acquisition rate (events/second) is erratic.

The background light level is high (this should be less than 1.0 for all detectors)

Incorrect calibration bead histogram channel number: the calibration beads fail to appear in the correct
histogram channel (+/-20%) with standard settings.

The absolute counting accuracy of the machine is poor. When Apogee calibration beads are run at
2.1ul/min for approximately 200 seconds, the concentration of particles (evt/ul) in the singlet peak is more
than 15% different from the labeled value.

Poor CV from test beads

When running a purified water control sample, too many events are counted.

See the below table for answers to these common questions.
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‘The data looks abnormal |

but the instrument settings
are thought to be correct.

| Why

To do

Dirty tubes or flow cell.
Reagent problems.

Run test beads followed by a
sample of filtered water or buffer
to verify the fluid tubes are clean.
A ‘Flow Cell Clean’ operation may
help to reduce optical noise but
will not reduce dirt particles in the
fluid system.

The Histogram Software
doesn’t communicate with
(cannot connect to) the
FCM Control software.

If running the two programs on the same

computer inside the machine:

e If the LAN connects after the FCM
Control software has started, it will
disrupt the connection between the
programs. The LAN connection must
not change after the FCM Control
program has been run. Some network
security programs may not be
compatible with the Apogee software
or may require than the FCM Control
program be started manually (instead
of from the Windows Startup folder),
after the LAN is fully established.

e Multiple copies of software running
(check the Windows Task Manager)
due to operator error or due to a
crash which prevented the program
from closing properly.

e Incompatible LAN connected
(disconnect from LAN and restart to
verify)

e TCP/IP LAN configuration error

Reboot the machine and the PC.

Check the network cable
connection on the rear panel of
the cytometer and PC.

Repeat the instrument start up
procedure (above).

Check that the ‘Connect to FCM’
check box is checked in the User
Configuration program.

Check the correct network name
or IP address is specified in the
User Configuration program.

The sample does not
automatically run when the
sample arm is moved to
the run position.

The software polls the sensor for a
change in the sample arm position.
Sometimes the timing may miss the
position change. Repeat the movement
or press the ‘Run’ button on the Control
tab.

If the sample still does not run then
check that the test tube is suitable (too
short or too long); it must not prevent the
sample arm from moving fully up into
position.

Transfer the sample to an
appropriate test tube.

The sample needle probe is
clamped by a nylon screw. The
height of the sample needle can
be adjusted to allow use of your
preferred sample tubes.

The flush doesn't start
automatically

Try clicking the ‘Flush’ button (green
button) on the FCM Control program.
If this does not fix the problem then the
sample arm is not fully in the flush
position.

Move the sample arm to the
flush position
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The cuin rate
(events/second) is erratic

To do

There may be an air

bubble in the sample
syringe or the sample
syringe may be worn.

The sheath filter may
be partially blocked
due to a large amount
of air in its inlet.

Click the 'Remove Air in Syringe' button'on
the Service tab of the Control Panel. This
automatically removes air from the sample

syringe.
Refer to section 11.2 and then 11.4

Refer to section 11.5 to test the sheath fluid
filter.

It should be less than 1.0 for all
detectors)

The background light level is high:

The flow cell is dirty or
the PMT voltage is too
high

Run a flow cell clean routine from the
Service tab of the Control Panel.

Perform a flow cell cleaning fluid soak
(button on Service tab)

As a temporary work around, reduce the
PMT voltage and use software Gain if
necessary to move the populations back to
the normal position.

The background light level is
high (> 1.0)

The OL&FC assembly
(flow cell) is damaged

Contact Apogee for technical assistance.
(support@ApogeeFlow.com)

Incorrect calibration bead
histogram channel number: the
calibration beads fail to appear in
the correct histogram channel (+/-
20%) with your standard settings
(PMT Voltages, Gain Settings,
Subtraction settings))

Optical fault

Check the background levels (see above)
and if necessary perform a flow cell clean
procedure.

If the background levels remain high, use
more software gain and lower PMT
voltages.

Incorrect calibration bead
histogram channel number

Fluidics fault

Check the connections to the fluid box.
Perform a ‘New Sheath’ and ‘Flow Cell
Clean’ procedure (service tab of histogram
software) to remove air from the sheath
fluid system and clean the tubes.

Perform the ‘Remove Air in Syringe’
procedure from the Service tab of the
control panel.
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The counting accuracy of
machine is poor.

When Apogee calibration beads
are run at 2.1ul/min for
approximately 200 seconds, the
concentration of particles
(evt/ul) in the singlet peak is
more than 15% different from
the labeled value.

Why

To do

The test beads have
deteriorated (e.g. clumped into
more doublets, triplets etc.)

OR: Air may have collected in
the sample syringe.

OR: The syringe is damaged
or worn.

Click the 'Remove Air in Syringe'
button on the Service tab of the
Control Panel. This automatically
removes air from the sample syringe.

Refer to section 11.2 and then 11.4

Bad CV on calibration sample

'R RN EEEEEREE

Remember that high sample
flow rates give high CVs.

An air bubble stuck in the flow
cell may be misaligning the
sample stream in the laser.

Check that you have selected the
normal sample flow rate.

Click the ‘Flow Cell Clean’ button on
the Service tab to dislodge any air
bubbles.

Low sheath flow rate gives
high CVs

Check the sheath pressure (sheath
fluid flow rate) is set normally. Try
increasing it.

Events are triggered by
detectors with an active trigger
threshold with. The cause may
be:

1. Optical noise spikes
above the trigger level;
the PMT noise level is
high, OR

2. Adirt particle in the
sheath fluid passes
through the laser; the
sheath fluid system is
dirty, OR

3. Adirt particle in the
sample or released by
the sample system
tubing passes through
the laser; the sample
system is dirty

Check the PMT noise levels on the
PMT tab of the histogram software.
Change a voltage by 1V to make the
noise values update after 10
seconds. If the noise is elevated (it
should always be kept less than
1.00), perform Flow Cell Clean cycles
and Flow Cell Soak cycles to reduce
the optical noise.

Establish whether the source of dirt
particles is the sheath fluid system or
sample fluid system by observing the
effect of changing the sample flow
rate. If the source is the sample
system (or sample), the event rate
will be roughly proportional to the
sample flow rate.

If the source is the sample system,
run a cleaning fluid as a sample and
perform several Flush cycles. If the
source is the sheath fluid system, run
a long sample of water and monitor
the event rate over 30 minutes to see
whether it cleans up. If not, the
sheath fluid filter and tubing may
need to be replaced
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11. Service and Maintenance Procedures

-

11.1  Routine Maintenance

Apogee Flow Cytometers have fully automated cleaning routines so that no operator mainterjance is
required under normal operating conditions. The user should, however, regularly run calibration beads to
monitor the general condition of the machine by checking:

e counting accuracy and precision

« for changes in the fluorescence and light scatter signal strengths and CVs

 light scatter noise level (the amount of background scattered light in the flow cell, see
PMT tab of histogram software)

To clean and disinfect the system after running biological samples, be sure to follow the Shutdown
procedure provided in section 8.4 to make sure the system is clean before it is turned off.

The recommended Preventative Maintenance interval ranges from 6 to 18 months depending on the
operator skill level and the application. Apogee offers a performance assessment service via remote
desktop connection which can help to ensure service visits are scheduled efficiently.

For maintenance procedures requiring removal of the covers, it is recommended to first turn all lasers off using the
check boxes on the Control Tab of Histogram Software. If the covers are removed and laser(s) are turned on, the
machine is then a Class 2M laser product; the system is safe for accidental exposure providing optical instruments are
not used to view or divert the laser light.

11.2 Testing the Sample System and Replacing the Syringe

The syringe should be replaced annually or whenever the system fails the tests described in the following
section.

11.2.1 Testing the sample system

The most common sample system faults are a worn syringe or air in the syringe. They can seriously affect
counting accuracy and precision.

If the counting accuracy is poor, automatically remove any air from the syringe by clicking the button on the
Service tab of the histogram software’s Control Panel.

Counting Accuracy Test:

To check for a worn syringe (or air in the syringe, or a leak or blockage in the sample fluidics) is to
measure the events per microliter at several sample flow rates. For example compare the events/pl at
1.5pl/min to 10.5pl/min, remembering to allow the event rate to stabilize after changes in the sample flow

rate.

Evts/pl values consistent to within 10% should be obtained for flow rates in the range 1.5 to 10.5ul/min.
The total counting rate (total event rate) should be kept below 10,000 per second to ensure the electronics
is not limiting the count rate. On older models (A20 and A40 generations) keep the event rate below 2,000
per second. If necessary dilute the sample.
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If the counting precision remains poor after changing the
syringe, test the syringe valve as explained in section 11.4.

Syringe piston
clamp screw
(grub screw)

To remove the syringe:

e Shut the machine down
Remove the right hand side cover

° Accurately record the position of the syringe piston
in the glass syringe. The height of the syringe
piston is critical to ensure the ‘Remove Air in
Syringe’ routine functions properly. Also note the
length of piston protruding above the grub screw
clamp bar.

e Loosen the plastic screw which clamps the glass
syringe.

e Loosen the small grub screw which clamps the
syringe piston (1.5mm ‘across flats’ (A/F) Allen key
for old type syringe, 2mm A/F for new type syringe)

e Gently turn the syringe pulley wheel to move the
syringe arm upwards to allow you to remove the
syringe more easily.

e Grip the plastic connector which joins the syringe
to the valve in order to stop it from turning when
you unscrew the syringe's Luer connector. With

Syringe glass
clamp screw
(nylon)

Syringe luer

your other hand, grip the flange at the top of the %ﬁgn:oc:::étor
glass syringe and unscrew the syringe from the between
plastic connector between the syringe valve and syringe and
syringe. valve is not

e The syringe can then be removed. The Luer
connector only requires about 1 turn of the syringe.

shown.

11.2.2 Mounting a new syringe

Syringe replacement is essentially the reverse of the removal procedure.

However, it is very important to make sure the syringe is clamped at the
correct height to ensure the ‘Remove Air in Syringe’ routine works
properly. The syringe glass is tapered for a distance of approximately
4mm from its opening. During the ‘Remove Air in Syringe’ routine, the
syringe motor drives the piston to this tapered section to completely fill the
syringe and to allow any air bubbles to escape by gravity. The syringe
piston height must be set precisely for this to operate correctly. The piston
must reach the tapered section of the glass so that any air bubbles can
escape, but the piston should not escape completely from the glass (1mm
should remain inside) to avoid the possibility of the piston not returning
correctly into the glass.

Syringe can
be removed
through this
gap

Furthermore, the length of the syringe glass is not always consistent from
syringe to syringe, so after fitting a new syringe it is essential to verify the
piston is set correctly by performing a ‘Remove Air in Syringe’ operation,
and checking that all but 1mm of the piston comes out of the glass, and
checking that a little water flows out of the syringe (taking any air bubbles
with it).
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After replacing the syringe, air must be removed from the new syringe. This is most easily done by
performing several ‘Remove Air In Syringe’ operations by clicking the button on the Service tab of the
Control Panel in the Histogram Software. Watch the mechanism as you do these to ensure all air is indeed
removed from the syringe.

A40 generation cytometers are fitted with a different type of syringe drive, but the principles are the same.
See image below.

Grub screw (1.5mm
AJF) to clamp the
syringe piston

Tapered section of syringe glass
(approx 4mm from opening).

Grip the glass flange to unscrew the
syringe from the valve connector.

Plastic clamp screw

Valve connector.

Do not to allow this plastic
connector to turn when
unscrewing the syringe.

' Old Type Syringe Drive J Syringe valve
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AB0 generation cytometers have the syringe drive
mounted at the front of the instrument for easier access
when an Autosampler is fitted, but the procedure for
changing the syringe remains the same as for the A50
generation.

Notes:

After removing the syringe, & wormn syringe can be sensed by gently
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along the length of the syringe, and comparing the resistance to pist
movement with a new syringe

o

‘R NN

and ready for a sample. The sampie arm must be in the flush positio
preparation for the flush cycie which occurs after the air has been rex

)

The ‘Remove Air In Syringe’ button is disabled unless the machine s die
nmn

Q out of the
syringe, then there is a problem with the sheath fluid filter or
sheath fluid from the tank. See Advanced User Manual section namead

“Fluid Section: Technical Description” for detais

If air gots sucked into the syringe instead of water flowing
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pumping the piston in and out and feeling whather the resistance is uniform

moved

Note that air is removead by gravity (the waght of water in the shaath tank)
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11.3  Flow Cell soak in cleaning fluid to correct elevated light scatter PMT noise levels

Over time, the light scatter PMT noise levels may increase due to deposits on the optical surfaces in the
flow cell. To correct this is may be necessary to soak the flow cell in cleaning fluid for longer than is done
during the Flow Cell Clean routine. Histogram software versions after 255.0.0.155 offer a “Flow Cell Soak”
button on the Service tab.

If an earlier version of software is installed, it is possible to clean these surfaces by manually controlling
}/allves and pumps using the Terminal program installed on the cytometer's computer. The procedure is as
ollows:

With the machine idle and all lasers turned off

Run the Terminal program

On the "Vac Pmp" tab click "Vacuum Pump Speed 3"

On the "Valves" tab click "Clean Valve"

Wait 30 seconds

On the "Vac Pmp" tab click "Vacuum Pump Off"

On the "Valves" tab click "Turn Off Valves"

Leave the machine for 20 mins for the flow cell to soak with cleaning fluid inside

Tell the machine to Flush three times (button on Control Panel of the Histogram Software)
Run a sample of water.

Turn the laser(s) back on and change any of the PMT Voltages by 1 Volt to cause the
machine to read the noise levels

If the noise levels are significantly lower you may repeat this process until the noise levels
are normal.

FTTT@moa0 o

11.4 Syringe valve test (event rate instability/poor counting precision)

To address poor counting precision, first consider the steps in
section 11.2: worn syringe or air bubble in the syringe. If the
events per microliter readings remain imprecise after changing the
syringe, consider a possible faulty syringe valve.

b}

$
1
:
t

If the syringe valve does not seal correctly, the counting precision
will be poor and the events per microliter will be erratic. Typically
the events per microliter will be elevated at very low flow rates and
suppressed at high sample flow rates.

The syringe valve connects the syringe to a supply of sheath fluid
when turned on, or to the flow cell (via the sample valve) when
turned off.

The syringe valve may be tested while running a sample by
monitoring the event rate (plot a histogram with TIME on the x
axis) when you squeeze the sheath supply tube (see red crosses
in photo) and hold it closed for about 10 seconds. Squeezing the
syringe valve's sheath fluid supply tube should have no effect on
the event rate. If the valve is failing to seal, the event rate will
change when you squeeze the sheath supply tube and the valve
should be replaced
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If the flow rate under 30cm of gravity is too low, the filter membrane should be re-wetted with alcohol.

Filter wetting procedure:

10.
11
12.
. Replace the cytometer's side cover.
14.

11.6 Packing the Cytometer for Shipment

If the cytometer needs to be transported, it is best packed on a pallet following the below
recommendations

A | apogeE

11.5 Testing and re-wetting the sheath fluid filter

If the sheath fluid filter cartridge is larger than the cleaning fluid filter cartridge, it will be a hydrophobic type
which blocks water flow if the cartridge fills with air. If the sheath tank has been allowed to run dry, air will
have been sucked into the sheath filter and the membrane may require re-wetting with alcohol (ethanol or
methanol). The test and rewetting procedure is as follows:

Sheath filter test:

Turn off the machine |
Remove the fluid tank

Remove the cytometer's side cover on which the fluid tank normally sits.

Disconnect the luer connector on the Sheath fluid filter outlet tube and place it in a large
beaker.

Secure the side cover so it cannot topple over while still allowing you access to the sheath
filter outlet tube.

Top up the sheath tank so that the height difference between the water in the sheath tank
and the end of the tube in the beaker is about 30cm.

Re-connect the fluid tank

Water will now flow from the tank, through the filter, into the beaker. Measure the flow rate;
it should be at least 45ml per minute.

Pull off the blue connector (the connector which normally connects to the sheath tank)
from the tube on the sheath filter inlet.

Water will now flow by gravity into the beaker, filling the filter inlet with air. If the filter inlet
does not fill with air, tilt the filter unit and try to empty water in the inlet side of the filter out
through the filter cartridge bleed port (disconnect the Luer connector). It is important to
eliminate most of the water from the unfiltered (inlet) side of the filter cartridge.

When the inlet side of the filter cartridge is full of air, plug the filter outlet tube (the tube in
the beaker).

If not already done in step 10, disconnect the filter bleed port tube (Luer connector) to
allow air out of the filter in the next step when you inject alcohol.

Inject approximately 100ml of ethanol (>95%) into the filter until it starts to flow out of the
bleed port.

Reconnect the tube to the filter bleed port Luer connector.

Reconnect the blue connector to the sheath fluid inlet tube.

Connect the blue connector to the sheath tank and unplug the filter outlet tube so water
flows into the beaker.

Measure the water flow rate. It should be at least 45ml/min with 30cm height of water (tank
water level to beaker).

Allow at least 2 litres of water to flow through the filter to flush away the ethanol.
Disconnect the sheath tank and remove it from the cytometer's side cover

Reconnect the sheath filter outlet tube's Luer connector.

Reconnect the sheath tank and test that the problem is solved.
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To pack an ApogeeFlow cytometer

Empty all fluid tanks :
Ship the cytometer upright. It is not designed for shipping in any other orientation
Preferably put inside an ApogeeFlow travel case as shown in the images below
Always ship on a pallet because the pallet gives protection against big impacts and
ensures the system is kept upright

Use a generous layer of firm foam between the cytometer and the pallet

e Strap the cytometer to the pallet with strong strapping

When sending a cytometer to ApogeeFlow for repair

e Decontaminate the system before shipping by wiping surfaces
with a disinfectant

e Do not send the waste tank, monitor, keyboard, mouse
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